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1.  

2.  

1.  

2.  

1.  

2.  

The installation process depends on the distribution type and your Operational System.

The installer distribution is the recommended way to install DBeaver on Windows and MacOS X. It contains all 
required dependencies. In addition, the installer automatically upgrades DBeaver to the new version if a previous 
version has already been installed. To install DBeaver, run the installer executable and follow the instructions on 
its screens.

NOTE:

The installer does not change any system settings or the Java installation.

The included JDK will be accessible only to DBeaver.

When installing DBeaver manually, without using an installer:

Extract the contents of the archive.
NOTE: Do not unzip the archive over a previous DBeaver version. If you already have any version of 
DBeaver extracted in the same location - remove it before unzipping the new version.
NOTE: All configurations, scripts and other necessary data are stored in a separate location (usually in the 
user`s home directory) so the program deinstallation does not affect them.

Run the  executable.dbeaver

To install DBeaver using a Debian package:

Run .sudo dpkg -i dbeaver-<version>.deb

Execute .dbeaver &

To install DBeaver using RPM package:

Run .sudo rpm -ivh dbeaver-<version>.rpm

Execute .dbeaver &

NOTE: To upgrade DBeaver to the next version, use  parameter.sudo rpm -Uvh dbeaver-<version>.rpm

Installation

Windows / MacOS Installer

ZIP Archive

Debian Package

RPM Package
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The DBeaver window contains a menu bar, a toolbar, a shortcut bar, a workspace with one or more editors and 
views, and a status bar: 

By default, the menu bar contains the following menus:

File menu contains menu items for the creation of files, folders, projects, database connections, database 
projects, and ER diagrams as well as Import and Export items.

Edit menu contains global commands like Cut, Copy, Paste, and Delete targeted at the active element.

Navigate menu allows navigation through scripts and database objects.

Search menu provides options to search among files, database objects and across data.

SQL Editor menu is for opening SQL Editor and managing its appearance.

Database menu allows management of database drivers, connections and transactions, as well as 
reconnecting to and disconnecting from a database.

Window menu includes items to manage the look of DBeaver window: show/hide and minimize/maximize 
views and editors, display bars, split editors, and manage other preferences.

Help menu contains links to information and help resources, as well as menu items to check the version 
number and availability of updates.

Application Window Overview

Menu Bar
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You can customize the menu bar and the list of menu items to display, for this, go to Window -> Customize 
 tab.Perspective -> Menu Visibility

The toolbar contains buttons for the most basic and frequently used commands: 

Some of the buttons are enabled (colored), others are disabled (grey). The sets of enabled and disabled buttons 
change depending on which editor is currently active in the workspace. Only enabled buttons are applicable to the 
active view or editor.

You can customize the toolbar, for this, go to  tab.Window -> Customize Perspective -> Tool Bar Visibility

You can hide or show the toolbar in the application window. To do it, go to the Window menu, click Appearance -> 
.Hide Toolbar / Show Toolbar

There are two shortcut bars - one on the left and one on the right side of the workspace zone. Shortcut bars host 
shortcuts of views and editors and appear if at least one view or editor is minimized, otherwise they are hidden.

Views are windows within the workspace that provide presentations and ways to navigate the information. For 
more information about particular views, see  article.Views

Editors are windows in which you can interact with the content of files and databases. For more information about 
particular editors, see the  article.Editors

Both views and editors can appear as separate windows or as tabs stacked with other views/editors in a tabbed 
window. The following image shows the title bar of a tabbed window. If tabs do not fit in the title bar of a tabbed 
window, they become hidden. To see the list of hidden tabs, click the Show List icon that also indicates their 
number:

There can be several views and editors opened simultaneously in the workspace but only one of them can be 
active at a time.

You can change the layout of the workspace by opening and closing views, docking them in different positions in 
the workspace, collapsing them to the shortcut bar, or expanding them to occupy the whole workspace and 
restoring them to the latest docked position.

Toolbar

Shortcut Bar

Workspace: Views and Editors
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You can move views and editors around the workspace and dock them in different positions:

As a tab in a tabbed window

As a separate window with a vertical or horizontal layout in any zone of the workspace

You can also swap locations of two views or editors.

To dock a view to a position in the workspace, press and hold the title bar of the view, then drag and drop it onto 
the desired position.

You can resize the view and editor windows. To resize, place the cursor to the border of the window until it 
changes to a double-ended arrow, then click and drag the border to the needed size.

To close a view or editor, click the Close button, or right-click the title bar of the view / editor, then click one of the 
options on the context menu (they change depending on the configuration of windows):

Close - to close the active window or tab in a tabbed window

Close Others (for editors and views that appear as tabs in tabbed windows) - to close all tabs of the current 
tabbed window except the active tab

Close Tabs to the Right / Left (also for tabbed windows) - to close all tabs of the current tabbed window that 
are located to the right / left of the active tab

Close All - to close all tabs of a tabbed window (close the window)

All views and editors have the Close, Minimize and Maximize buttons: 

The Maximize button changes to the Restore button when a view or editor is maximized.

To maximize a view or editor to the size of the whole workspace, do one of the following:

Click the Maximize button in the upper-right corner of the view.

Double-click the title bar of the view or editor.

On the Window menu, click .Appearance -> Maximize Active View or Editor

When one view is maximized, other views and editors appear as shortcuts on the shortcut bar.

To restore a maximized view or editor to its latest docked position, double-click its title bar or click the Restore 
button in its upper-right corner.

Changing Workspace Layout

Maximizing, Minimizing and Restoring View and Editors
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When you minimize a view, it wraps into a shortcut on the shortcut bar: 

The shortcuts of views and editors may appear on the left or on the right shortcut bar depending on the latest 
docked position of the view or editor.

To minimize a view, do one of the following:

Click the Minimize button in the upper-right corner of the view.

On the Window menu, click .Appearance -> Minimize Active View or Editor

To restore a minimized view or editor to its previous position, click the Restore button on its shortcut in the shortcut 
bar. To restore a minimized view or editor to a new position, click the view / editor name button under the restore 
button.
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Views are windows within the workspace that provide presentations and ways to navigate the information. The 
main views in DBeaver are: ,  and .Database Navigator Projects Project Explorer

To open a view:

On the Window menu, click  and then, on the submenu, click the name of the view. Click  if Show View Other
the view is not visible on the submenu.

For Database Navigator, Projects, and Project Explorer views, on the Window menu, just click the name of 
the view.

Some views open on demand, for example the  view opens to show search results.Search

Views provide their own toolbar and menu:

To open the view menu, click the View Menu button in the upper-right corner of the view`s title bar, next to the 
Minimize button.

The toolbar contains buttons applicable to the objects displayed in the view. The set of enabled and disabled 
buttons depends on the object in focus.

Views also provide context menus for objects they display. To open a context menu for an object, right-click the 
object.

Views
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Database Navigator is the main view to work with the structure and content of databases. To open Database 
Navigator, on the Windows menu, click . For information on how to change the view layout, Database Navigator
please see the  article.Application Window Overview

Database Navigator contains a tree of objects, a toolbar and View menu which contain generic items. Each object 
in the tree has its own context menu. The tree contains the following objects:

Folders - 

Database connections -  and other (icons differ depending on the database type)

Database objects - various depending on the database type, such as Tables , Views , Columns  , 

Indexes , etc.

To open the view menu of Database Navigator, click the View Menu button ( ) in the upper-right corner of the 
window. For more information on where to find the view toolbar and menu, please see the  article.Views

The menu contains the following items:

Icon Menu item Description

Driver 
Manager

Opens the Driver Manager window that allows you to create, edit and delete drivers for databases. 
See  for information about managing database drivers.Database Drivers

Database Navigator



DBeaver User Guide 21.0. Page 13 of 334.

New 
Connection

Opens the Create new connection wizard. See  for information about creating Create Connection
connections.

(empty)
Active 
Project

Displays a submenu which allows you to choose a project. See  and  for Projects Projects view
information about projects.

New 
Folder

Opens a dialog box for creating a new folder

Collapse 
All

Collapses the tree to the root level

Link with 
editor

Synchronizes the active editor with the element in the database navigator

The toolbar is located in the title bar of the window. Its buttons duplicate the menu items, except for the Active 
.Project

To open the context menu for an object, right-click the object in the tree. The following table summarizes the 
context menu items for all types of objects that may appear in the tree. Note that the presence or absence of the 
context menu items for an object depends on the database and object types.

Menu item Description

Open folder Opens a folder in a separate view

Create new connections / 
Create New Connection

Opens the Create new connection wizard

New Folder Opens a dialog box for creating a new folder

Copy Copies an object to the clipboard

Paste Inserts the copied object into a selected folder - most convenient for copy-pasting connections

Delete
Deletes an object

 The Delete menu item removes the object not only from the tree but from the WARNING!
database itself or the file system, and this action is irreversible.

Rename Opens the Rename [object] dialog box

Properties
Opens the Properties for [object] window which allows viewing and modifying the object`s 
properties

Refresh
Depending on the object, refreshes the object itself, or its parent, or its subnodes – mostly 
used for refreshing tables and schemes

Connect Attempts to connect to the database

Invalidate/Reconnect Checks the status of connection, if it is broken, attempts to reconnect

Disconnect Disconnects from the database

SQL Editor Opens a new SQL editor for the connection

Recent SQL Editor Opens the most recently opened SQL editor

Edit Connection Opens the Connection Configuration window that allows configuring connection settings

View [objects] Opens the object in a separate viewer

Edit [object] Opens the object in a separate editor

Create new [object] Opens an editor in which you can specify properties and save the new object

Opens a submenu of one or more filtering options (depending on the object):
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Filter

- Hide [object]
- Show only [object]
- Configure [objects] filter
- Toggle filter
- Clear filter
See  for information.Filters

Copy Advanced Info Copies the full name of an object

Read Data in SQL Console Opens an SQL console displaying the object`s data

Compare
- Appears only if you select several objects of the same level
- Opens the Compare objects wizard which guides you through the steps to generate a 
comparison report for the selected objects

Generate SQL

Opens a submenu on which you can select the type of SQL query to generate:
- SELECT
- INSERT
- UPDATE
- DELETE
- MERGE
- DDL
Clicking one of the items (for example INSERT) generates a relevant query in a separate 
window.

Export Table Data Opens the Data Transfer wizard that helps you select a format and export table data

Import Table Data
Opens a window with existing database connections in which you can select a table to import 
data from

Tools Opens a submenu that provides tools for database backup and restore, vacuum, etc.

For information on how to filter database objects in Database Navigator, please see the  Filter Database Objects
article.
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1.  

2.  

In the  and  you can filter database objects to include or exclude some Database Navigator Database Object Editor
of them from the view. You can filter schemas, tables, views and procedures. A dots sign  next to the (...)

node`s name indicates that a filter is applied to its sub-nodes: 

There are several ways in which you can filter objects. One of the ways is to filter objects by the names of tables 
and views using the filter field above the tree of objects:

To filter objects by the name of a table and view, type the name in the field. The tree dynamically updates to show 
tables / views with that name. To reset the filter, click the Clear icon ( ) on the right end of the field.

Another way to filter objects is to use the  item on the context menu of a single object. To filter objects using Filter
the  menu, right-click the object, then click  on the context menu, and then click one of the items on the Filter Filter
submenu:

Filter 
submenu 
item

Description

Hide ‘[object 
name]’

Hides the current object while displaying the other ones

Show only 
‘[object 
name]’

Shows the current object while hiding the other ones

Toggle filter Inverts the filtering – shows hidden objects and vice versa

Clear filter Removes the filtering to display all objects

Configure 
[objects] filter

Appears only to the folder or parent nodes of database objects - like ‘Tables’, ‘Indexes’, etc. Allows the 
creation of a complex filter with multiple filtering criteria, see .Configure Filters

A third way of filtering is to use the  item on the context menu on several objects:Filter

Select several objects of the same type using Ctrl or Shift keys.

Right-click the selection, then click , and then choose one of the options on the submenu:Filter

Filter submenu item Description

Hide N objects Hides the selected objects while displaying the rest

Show only selected objects Shows the selected objects while hiding the rest

To reset such filters, right-click the parent (folder) node displaying the dots sign , and then click (...) Filter -> 
.Clear filter

Filter Database Objects
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1.  

2.  

3.  

4.  

5.  

You can configure custom filters to filter database objects in the  and .Database Navigator Database Object Editor

To configure a custom filter:

In the Database Navigator, right-click the object and on the context menu click Filter -> Configure [objects] 
. In the Database Object editor, in the toolbar of the  tab, click the Filter settings button ( ). filter Properties

The Filtering window opens.

Select the  checkbox to activate the fields of the window.Enable

If you want the filter to apply to all objects of a certain type, for example to all schemes, click Show global filter
. Otherwise, the filter will apply only to the current object. NOTE: Once you apply the global filter, you cannot 
revert back to the local filer in the same window. To create a local filter, reopen the Filtering window, see Step 
1.

For objects that you want to show, click  next to the  field and then, in the field itself, enter the Add Include
name or combination of symbols to search. For objects that you want to hide, click  next to the  Add Exclude
field and then, in the field itself, enter the name or combination of symbols to search. NOTE: You can use 
masks with  and  to replace one or more symbols and  to replace one symbol in the search % * _

combination.

To remove one filtering combination, click the combination in the field and then click . To remove all Remove
combinations from either of the fields, click  next to the field.Clear

Configure Filters
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6.  

7.  

8.  

Once you set all filtering criteria, you can save a filter to use for other objects. To save the filter, in the Saved 
filter area, in the  field, enter the filter`s name and click .Name Save

You can also remove any of the saved filters. To remove a filter, in the  drop-down list, click the filter Name
name and then click .Remove

Click  to apply the filtering criteria. Otherwise, click .OK Cancel
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You might need to classify and group database connections into projects. Projects store objects related not to a 
particular database but to all database connections. These are usually files stored on the file system.

The Projects view displays all projects created in the system and provides tools to manage them. To open the 
Projects view, on the  menu, click  (or use  shortcut).Window Projects ALT+W+P

For information on how to change the view layout, please see the  article.Application Window Overview

The projects are organized into a tree and all have the same high-level structure:

Connections – repeat the content of the Database Navigator view for this project. You can perform the same 
actions over the objects of the databases as in the Database Navigator.

Bookmarks – contains bookmarks – shortcuts to database objects, see …

ER Diagrams - contains ER diagrams that you can drag-and-drop here from other folders

Scripts – contains scripts that you can drag-and-drop here from other folders

The Projects view provides a toolbar and View menu which contain generic items. Each object in the tree has its 
own context menu.

To open the view menu of the Projects view, click the View Menu button ( ) in the upper-right corner of the 
window. The view menu contains the following items:

Icon Item Description

Projects View
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Create Project Opens the Create Project wizard

Refresh Projects Refreshes the projects tree to display changes caused by creating modifying or deleting projects

Collapse All Collapses the tree to the root level

Link with editor
- Enabled when at least one editor is open, otherwise disabled
- Highlights the object in the tree that has its editor open

The toolbar is located in the title bar of the window, its buttons duplicate the view menu items except for the 
 one.Refresh Projects

To open the context menu for an object in the tree, right-click the object. For information about context menu items 
of all objects under the  node of the tree, please see . The context menus of other Connections Database Navigator
nodes in the tree contain some basic items for copy-pasting, renaming, deleting objects, managing their 
properties, creating folders, etc.

The  menu item (for a project root node) makes the project active, that is visible in the Set Active Project
Database Navigator.

The  and  menu items allow creating links to files and folders in the file Link File (SQL Script) Link Folder
system.

For information about managing projects, please see  article.Projects
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The Project Explorer view displays detailed contents of the currently active project. To open the Project Explorer, 
click .Window -> Project Explorer

For information on how to change the view layout, please see the  article.Application Window Overview

The title of the Project Explorer includes the name of the project: Project – [Project name].  is a project that General
initially exists in the system by default.

The Project Explorer displays the content of a project with metadata. The content includes: , Bookmarks ER 
, and . The metadata appears in columns which you can hide or show.Diagrams Scripts

The Project Explorer view provides a toolbar that contains the following buttons:

Button Name Description

Configure columns visibility Opens a dialog box in which you can select columns to display in the view

Collapse All Collapses the tree to the root level

Expand All Expands the tree nodes

Link with editor
- Enabled when at least one editor is open, otherwise disabled
- Highlights the object in the tree that has its editor open

To sort the metadata in the table by a certain column, click the column header.

Project Explorer



DBeaver User Guide 21.0. Page 21 of 334.

Query Manager is a view that shows the history of all SQL queries that DBeaver has executed during the current 
session.

NOTE: The DBeaver EE version persists all executed queries in the internal database so its execution history is 
available after the program restarts.

To open the Query Manager, do one of the following:

Click the arrow next to the  button in the toolbar and then click  on the Transaction Log Query Manager
dropdown menu:

On the  menu, click :Window Show View -> Query Manager

The Query Manager logs all queries together with their execution statistics (execution time, duration, number of 
fetched/updated rows, errors, etc.):

Query Manager
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You can modify the look of the Query Manager by filtering queries and setting the number of entries displayed per 
page, as well as specifying some storage settings, see the ‘Query Manager Properties’ section below.

To erase all entries from the Query Manager, click the  button ( ) in the view`s toolbar.Clear query manager log

To manage the look of the Query Manager, filter the entries, and modify the storage settings, click the Set query 
 button ( ) in the view`s toolbar. The Properties for Query Manager window opens:manager filter

Query Manager Properties
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To filter entries by object type, select or clear the checkboxes in the  section. To filter entries by Object Types
query type, select clear the checkboxes in the  section.Query Types

To change the number of entries displayed per page, enter the new number in the  field.Entries per page

To set DBeaver to save the query log in a file, select the  checkbox and then specify the file Save log to file(s)
location in the  field.Log files folder

After you make all necessary changes to the settings, click  to apply the changes and keep the window open Apply
or click  to apply the changes and close the window. To discard all changes and return to the Apply and Close
previous state, click .Restore Defaults
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You can open the Background view from the main menu - click , then in the Show Window -> Show View -> Other
View window, expand the  folder, click  and then click :General Background Tasks Open

You can also open the Background Tasks view from some other views or editors by using a special button, for 
example from the  view.Search

The Background Tasks view shows the progress of such background tasks as search, SQL query execution, etc. 
The view shows data when background tasks take some noticeable time and is useful when you want to track the 
progress of lengthy operations. If you open this view at a short task, the view will be empty.

You can cancel the task in progress - click the  button ( ).Cancel Operation

Background Tasks
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The Database object, or metadata, editor is available for multiple database objects such as tables, views and 
schemas. To open the metadata editor for an object, in the  or in the  view:Database Navigator Projects

Double-click the database object

Click the database object and press  or Enter F4

The editor has three tabs:

Properties tab appears for all objects, contains properties of the database object and its sub-entities, see 
further in this article

Data tab appears for tables and views and represents the Data Editor

ER Diagram tab appears for tables and schemas and displays ERD (Entity Relation Diagrams), see ER 
 and Diagrams Database Structure Diagrams

The tabs have the following common parts:

The object`s path shows the chain of all its parent entities. The entities are clickable: clicking an entity in the path, 
depending on its nature, either shows its children or opens an editor or a settings window.

The toolbar contains different tools on each of the three tabs.

An asterisk appears in the title of an editor if it contains unsaved changes:

The Database Object editor supports the  (undo) function.Ctrl+Z

Database Object Editor
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The Properties tab of the  provides you with the tools to view and edit the database Database Object Editor
object`s properties.

The content area of the Properties tab falls into two parts: the top pane displays properties of the current database 
object itself while the bottom pane contains properties of the object`s sub-entities or some complex properties like 
DDL (an SQL description of the current database object).

Properties of the sub-entities appear in the side tabbed editors – to open such an editor, click the tabs on the left 
side of the area:

The toolbar at the bottom of the editor provides the following tools for the majority of sub-entities except for some 
specific ones like Permissions (in PostreSQL) or SQL based views (DDL and Source):

Button Name Description

Search items
Displays a search field next to the button:
- Type in the search combination - the content updates dynamically
- To remove the filter, click the cross icon next to the search field

Filter settings Opens the Filtering window which allows setting a custom filter, see Configure Filters

Configure 
columns

Opens the Configure columns dialog box in which you can select the columns to display or 
hide in the current view

Refresh the 
selected items

Depending on the database type, refreshes either the current item or its parent or the whole 
database object – reloading data from the database

View Opens an editor/viewer for the item currently in focus

Properties Editor
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Create new 
[items]

Creates a new item of the same type as currently displayed in the open view, for example, a 
column

Delete database 
object

Deletes the item currently in focus

Save the current 
contents

- Same as the  button on the application main toolbarSave
- Same as Ctrl+S
- Opens the  window that allows saving changes in the currently open sub-Persist Changes
entity
NOTE: DBeaver recommends saving work after each change.

Revert to the last 
saved state

Reverts all changes made to the whole database object to the last saved state

Items in the tabbed editors have context menus which provide the same commands as those in the Database 
. To open a context menu for an item, right-click the item.Navigator

SQL script editors (  and ) of the Properties tab contain SQL script that you can either view or modify. DDL Source
The toolbar of the DDL and Source tabs provides the following tools:

Button Name Description

Load form file
- Allows selecting a file from the file system
- Disabled if the SQL code is read-only

Save to file Allows saving the current SQL code to a file

Open in SQL console Opens the SQL code in an SQL Editor

You can select parts of the SQL code and apply generic commands such as copy-paste or SQL-specific 
commands like formatting – using the context menu. To open the context menu, right-click the SQL code. See 

 for information about SQL-specific commands.SQL Editor

NOTE: , , and  menu items on the context menu are disabled if SQL Assist SQL Template SQL Context Information
the SQL script is read-only.

SQL Script Editors
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The Data editor appears:

As the  tab of the , which is only available for tables and views.Data Database Object Editor

As the  tab when you run a custom SQL query in Results SQL Editor

The Data editor allows the viewing and data editing of a database table or view. The central part of the Data editor 
is the data table. The editor also provides two toolbars and a filter field:

To learn how many rows the data table contains, click the  button in the bottom toolbar. Calculate total row count

The number of rows appears in a status field next to the button: 

To learn about ways to navigate data in the data table, see  article.Navigation

The top toolbar contains the following buttons:

Button Name Description

Apply filter criteria
Applies filter criteria entered in the filter field above the data table, see  article Data Filters
for more information

Remove all filters
/orderings

Removes all filters and orderings applied to the data

Save filter settings for 
current object

Saves the current filter settings for the database object to apply next time when you 
reopen it in the editor, see details in the  articleData Filters

Custom Filters Opens the Result Set Order/Filter Settings window, see article for more information

Configure auto-refresh Allows configuring data auto-refresh settings, see  article for detailsData Refresh

Forward and 
backward - history 
navigation buttons

Navigate forward and backward in the Data Editor history, see  section of History
 article for more information. The buttons are equivalent to pressing the key Navigation

combinations:  (backward) and  (forward).Alt+Left Alt+right

Data Editor
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The side bar contains the following tabs:

Button Name Description Chart_button

Grid Switches to grid view of data

Text Switches to plain text view of data

Chart Switches to chart view. For more details on charts, see the  article.Managing Charts

Record
- Same as pressing Tab
- Switches the positions of rows and columns so that the columns appear as rows, and the rows hide in 
one  column, see details in the  section of the article.Value Table vs. Record Views

The bottom toolbar provides the following buttons:

Button Name Description

Save
Saves all unsaved changes to the data such as adding, duplicating, deleting rows, inline 
editing of values, see  article for informationthe Data Viewing and Editing

Cancel Discards all unsaved changes to the data

Script
Opens the Preview Changes window in which you can see changes that you have made to 
the data, see details in the  articleData Viewing and Editing

Edit cell value in 
separate dialog
/editor

Opens the cell in focus for editing in a separate editor or dialog box, see details in the Cell 
 section of the  articleEditor Data Viewing and Editing

Add new row
Adds a new empty row below the current row, see details in the Adding, Copying and 

 section of the  articleDeleting Rows Data Viewing and Editing

Duplicate current 
row

Copies the current rows and pastes the copy below the current row, see details in Adding, 
 section of  articleCopying and Deleting Rows Data Viewing and Editing

Delete current row
Colors the rows in focus in red to mark them for deletion, see details in the Adding, 

 section of the  articleCopying and Deleting Rows Data Viewing and Editing

Move to first row Moves the focus (highlighting) from the current to the first row of the table

Move to previous 
row

Moves the focus (highlighting) from the current to the previous row of the table

Move to next row Moves the focus (highlighting) from the current to the next row of the table

Move to last row Moves the focus (highlighting) from the current to the last row of the table

Fetch next page of 
results

Fetches the next portion of data (next N rows) making it ready for display, see Scrolling 
 section of  article for more informationResults Page Navigation

Fetch all rows
Fetches the whole result set making it ready for display, see the  Scrolling Results Page
section of the  article for more informationNavigation

Panels Opens panels on the right side of the Data Editor, see the  for informationPanels

Configure Opens a dropdown menu with settings

JSON
- Available in EE version only for MongoDB documents and JSON tables
- Switches to JSON view of data

XML
- Available in EE version only for XML tables
- Switches to XML view of data

Generate Mock 
Data

Available in EE version only. Opens the  windowMock Data Generator
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Rows count details Opens the Status details dialog box showing the timing details of fetching table rows

Calculate total row 
count

Calculates the total number of rows in the table

Every cell in the data table has a context menu – right-click the cell to open the menu. The context menu provides 
the following items:

Menu Item Description

Cut Cuts the content of the current cell or column to the clipboard

Copy Copies the content of the current cell or column to the clipboard

Advanced 
Copy

Opens advanced copy submenu that allows copying data with preset formatting parameters

Paste Pastes the copied content to the cells in focus

Advanced 
Paste

Pastes several values delimited with a tabulation or line break

Delete
Deletes the row that has the cell in focus
NOTE: In fact, when users click , the system only highlights the red row while the actual deletion happens Delete
when users click .Save

Edit cell
- For CLOB/BLOB data format, opens the contents of the cell in a new tab
- For all formats except CLOB/BLOB, opens a properties window for the cell

Inline edit
- Same as double-click on a cell
- Makes the cell editable

Set to 
NULL

Sets the value of selected cells to NULL

Hide 
column

Hides the column currently in focus, see the Managing Display of Columns in Data Table section further in this 
article

Save to 
file…

- Appears only for columns with BLOB/CLOB data
- Opens the standard Save As window that allows saving data contained in the cell to a file

Load 
from file…

- Appears only for columns with BLOB/CLOB data
- Opens a standard window for opening files

Order
/Filter

Displays a submenu that allows selecting filter criteria for the data. The submenu contains the most common 
filters that can be applied to the cell in focus – see details in .Data Filters article
By default, DBeaver filters data by sending a request to the server (the Server-side results ordering checkbox 
selected). To filter data on the client side using DBeaver`s internal algorithm, clear the checkbox.

View
/Format

Opens a submenu that provides tools for formatting and modifying the view of data, see Data View and Format

Navigate Opens a submenu that helps users navigate throughout the data table, see Navigation

Layout Changes the layout of data, see the  section of the  articleTable vs. Record Views Data View and Format

Export 
Resultset

Opens the Data Transfer wizard that guides you through the steps to select a format and export data
NOTE: The system exports the whole result set including records that are not visible in the screen and preserves 
all applied data filters and ordering.

Generate 
SQL

Opens a submenu on which you can select the type of SQL query to generate

Refresh Refreshes the whole results set including all items that are not visible in the screen



DBeaver User Guide 21.0. Page 31 of 334.

For more information about using the Data Editor, please see the subsections of this article - open them via the 
contents tree on the right.
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If the result set has many rows, you can scroll the results page. To learn how many rows the data table contains, 
click the  button in the bottom toolbar. The number of rows appears in a status field next Calculate total row count

to the button: . Alternatively, you can right-click a cell in the table and then click  Navigate -> Row Count
on the context menu.

By default, DBeaver limits the number of rows fetched to  (you can change this value in the main toolbar or in 200
preferences). The maximum number of rows that DBeaver fetches to display in the Data tab is specified in the 

Maximum result-set size field in the main toolbar: `

Once you scroll to the last row of the current result portion, DBeaver fetches the next portion (next N rows). You 
can disable this behavior in preferences. You can also manually fetch the next portion of data equal to the 

maximum result set size. To do so, click the  button ( ) in the bottom toolbar or right-Fetch next page of results
click the table and click  on the context menu.Navigate -> Fetch next page

The number of rows fetched is visible in the status field under the data table: 

To see the details, click the details button in the status field.

To fetch the whole result set, click the  button ( ) in the bottom toolbar or right-click the table and Fetch all rows
click  on the context menu.Navigate -> Fetch All Data

NOTE: Be careful when fetching the whole result set. If it is huge, it might cause program hangup or out-of-
memory errors.

You can navigate through the result set using standard shortcuts , , , , , Home End PgUp PgDown Ctrl+Home Ctrl+End
.

To jump to the first or last row or move one row forward or backward, use the navigation buttons in the bottom 

toolbar or on the context menu: 

Navigation

Scrolling Results Page

Data Rows
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To jump to a specific line, right-click anywhere in the table and click  ->  on the context menu. Navigate Go to Line
Then in the Go to Row dialog box, enter the row number and click .OK

DBeaver remembers the history of such actions as applying filters to data, opening reference tables or other tables 
via links. You can navigate among such tables and filtered views:

Use the forward and backward buttons in the top toolbar: 

Click  or Ctrl+Left Ctrl+Right

Hovering over these buttons displays the names of the tables or filtered views saved in the history.

You can navigate by foreign keys or to referencing tables – those that reference the current table. To open a 
referencing table, press  or right-click the cell and click :Ctrl+1 Navigate->Referencing tables->[table name]

The referencing table opens in the same editor. To navigate back and forth between the initial and referencing 
tables, use the history navigation buttons ( ) in the top toolbar of the editor. In order to open referencing table 
in a new window use  shortcut to show menu.Ctrl+Shift+1

In the data editor, you can navigate to linked tables – the ones that the current table references. To open a linked 
table, click the Navigate link icon in a cell that contains it:

Another way is to right-click such a cell and click  on the context menu. The linked table Navigate -> Navigate link
opens in the same editor, filtered by the cell value:

NOTE: The table name in green above the table indicates which table is currently open in the editor.

History

Navigate Foreign Keys / Referencing Tables

Navigation Links
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To navigate back and forth between the initial and linked tables, use the history navigation buttons ( ) in the 
top toolbar of the editor.
You can open a linked table in a separate editor. To do so, simultaneously hold the  key (or  Ctrl # command
key on macOS) and click the Navigate link icon ( ) in the cell.
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The main tool for managing the appearance of the data table is the Result Set Order/Filter Settings window.

To open this window, click the Custom Filters button ( ) in the top toolbar of the editor or click the Configure 

button ( ) and then click  on the dropdown menu.Order/Filter

The Result Set Order/Filter Settings window provides tools to:

Order data inside columns

Manage the display of columns in the table

Manage the order of columns in the table

Filter data in the table using an SQL expression, see … below

Another tool for managing data appearance are column headers. In the data table, every column header contains 
three elements each having its own function: Data (column) type icon, column name, filter icon, and ordering icon.

Simply clicking the column name or column type icon highlights the whole column.

You can click the column type icon and then drag and drop the column to a different position in the table.

You can click the column name and then drag the cursor right or left to highlight multiple columns.

Clicking the ordering icon allows ordering the data in the column in ascending or descending order - see 
'Ordering Data in Columns' section further in this article

Clicking the filter icon allows filtering the data by a cell value, see [TBA]

Data View and Format
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1.  

2.  

1.  

You can order data in columns in one of the ways:

Click the ordering icon ( ) in the header of the column.

The icon has three states:

Clicking once establishes ascending order ( )

Clicking a second time changes the order to descending ( )

Clicking a third time removes the ordering from the column ( )

To order data by several columns, go column by column, setting the order with the Ordering icon, starting from the 
column by which you want to order data first.

Click the Custom Filters button ( ) in the top toolbar of the editor to open the Result Set Order/Filter Settings 
window (see above):

a) Next to the column by which you want to order data in the first turn, set the ascending or descending order 
using the same three-state principle as described above.
b) Set the ordering in other columns by which you want to sort data in the second, third, etc. turn. The  Order
column indicates the order in which the sorting will happen.
NOTE: The number ( ) column indicates the initial order of columns.#

c) To easily move the ordering setting from column to column, you can use the Move up/down/to top/to 

bottom/ buttons: 

To reset the data ordering to its initial state, click the Reset button ( ) in the same window.

Also, to remove all ordering settings, click the Remove All Filters/Orderings button ( ) in the top toolbar of the 
Data Editor.

To hide a single column, right-click the column or any cell in it and click  on the View/Format -> Hide column
context menu. To unhide a hidden column, open the Result Set Order/Filter Settings window (see the image at the 

beginning of in this article) and select the checkbox next to the column name or click the Reset button ( ).

To display or hide columns in the data table, in the Result Set Order/Filter Settings window:

Select the checkboxes next to the columns that you want to see in the table and clear the checkboxes next to 
those that you want to hide.

Ordering Data in Columns

Managing Display of Columns in Data Table
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2.  

1.  

2.  

3.  

Use the Show All ( ) and Show None ( ) buttons at the bottom of the window.

You can modify the order of columns in the data table in two ways:

Click the icon in the column header and drag-and-drop the column to a new position.

To sort column alphabetically, in the Result Set Order/Filter Settings window (open by clicking the Custom 

Filters button ( ) in the top toolbar of the editor), click the Sort button ( )

In the Result Set Order/Filter Settings window, click the column to set focus to it and then move it using the 

navigation buttons: ( )

You can switch between two data presentations in SE version and four presentations in EE version. Pressing CTRL+~
switches available presentations in turn.

To see data in a grid view, similar to Excel spreadsheet, click the  button ( ) in the bottom toolbar Grid
of the editor.

To switch to the plain text view, click  ( ) in the bottom toolbar.Text

To switch to JSON view (available in EE version only for MongoDB documents and JSON tables), click  JSON
in the toolbar.

To switch to XML view (available in EE version only for XML tables), click  in the toolbar.XML

The table view is a standard table (Excel-like) in which columns are vertical and rows are horizontal. This view is 

the default one. If you click the  button in the bottom toolbar of the editor ( ), or press , or Record Tab
right-click a cell and then click  on the context menu, the rows and columns switch positions – Layout -> Record
columns appear as rows, and rows hide in one  column which now shows only one row of data, and column Value
headers shift from the top of the table to its left side: 

Sorting Columns in Data Table

Grid vs. Plain Text Views

Table vs. Record Views
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The Record view is useful if the table contains a big number of columns. To navigate from row to row of data, use 

the navigation buttons in the bottom toolbar of the editor: 

To return back to the standard table view, click the  button again.Record

In the data editor, you can color all rows that have the same value as a particular cell of a certain column. To do 
so, right-click the cell and click  on the context menu:View/Format -> Set row color for {column name = value}

Then choose the color in the palette window that appears and click . The current row and all other rows that OK
contain the same value change their color to the one you selected:

To remove the coloring by a particular column, right-click the cell again and click View/Format -> Clear color for 
 on the context menu.{column name = value}

Rows Coloring

Coloring by Data Types
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Besides coloring rows by a value, you can colorize values in columns by data types. To do so, right-click any cell 
in the table and, on the context menu, click . Values in cells are colored in View/Format -> Colorize Data Types
different colors according to preferences currently set:

You can change the color preferences in the Preferences window: click  on the main Window -> Preferences
menu. Then, in the window, in the navigation pane on the left, expand  and then , and User Interface Appearance
then click :Colors and Fonts

To remove coloring by data types, on the context menu, click  again.View/Format -> Colorize Data Types

For string and numeric data types, DBeaver provides tools to transform the data presentation into a number of 
formats, such as URL and Binary for strings and Epoch Time, Number Radix, etc. for numbers. To change the 

Transforming Data Presentation
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data presentation in a certain column, right-click a cell in the column, then, on the context menu, click View/Format 
 and then click the presentation type name:-> Set {column name} format

The Transformer settings window opens showing the value in the chosen format. Click  to apply the change:OK

The values in the column appear in the new format.
NOTE: For URL format, the resulting cell provides a link to the URL in a browser window.

To roll back the changes to the default format, right-click any cell in the column, and on the context menu, click 
.View/Format -> View as -> Default

For complex data types (that themselves represent a structure), such as objects, structures and arrays, DBeaver 
provides a tool for breaking them into columns:

To do so, right-click a cell in the column and, on the context menu, click View/Format -> Visualize complex 
.columns

Structurizing Complex Data Types
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You can specify the exact format of Time, Timestamp, Date, and Number data used in the currently open 
database or globally. To specify a format, right-click any cell in the table and, on the context menu, click View

. The Properties window opens displaying the  page:/Format -> Data formats Data Formats

To configure the format for the current database only, select the  Datasource "[Connection name]" settings
checkbox. To configure the settings globally, to all databases that you have in DBeaver, click .Global settings
You can specify the locale for the data format in the  area, then, in the  dropdown list, click the name of Locale Type
the data type and then, in the  table, click the required format.Settings
To apply the changes and make them visible in the table, click  and then refresh the window (Apply and Close F5
).

Configuring Numeric and Time Data Formats
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You can apply custom filters to any table contents or query results. There are several ways in which you can filter 
data in the table.

One of the ways is to use the filter field above the table next to the top toolbar. To filter data, enter an SQL 

expression into the field and click the Apply filter criteria button ( ) next to the field or press .Enter

You can apply ready-to-use SQL expressions or SQL expression templates via the context menu. To select a 
ready SQL expression or a template, press  or right-click the cell, then click  on the context menu F11 Order/Filter
and then click one of the expressions.

The third way is to filter data by a cell value using the filter icon in the column header. To filter data this way, click 
the filter icon in the column header and then double-click the cell value in the Filter by column value dialog box:

Data Filters
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The data updates dynamically. To remove a filter, click the Remove All Filters/Orderings button ( ) in the top 
toolbar of the editor.

You can save the current filter settings for the database object to apply next time when you reopen it in the editor. 

To save the current filter settings, click the Save filter settings for current object button ( ) in the top toolbar.
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1.  

2.  

Refresh is necessary if the database contains changes made by other users working on it simultaneously with you 
and you want to see them in your DBeaver window. To refresh data manually, right-click anywhere in the data 
table and click  on the context menu or press .Refresh F5

You can also schedule auto-refresh to happen on a regular basis. To auto-refresh the database on schedule:

Click the Configure auto-refresh button ( ) on the top toolbar of the editor. The Auto-refresh configuration 
dialog box opens:

a) Set  in seconds.Interval
b) Select the  checkbox if you want the refresh to stop when it encounters an error or clear it, if Stop on error
the refresh should ignore errors.
c) Click .OK

Alternatively, click the arrow next to the Configure auto-refresh button ( ) to open the auto-refresh menu:

On the menu, you can click one of the preset options or click  to open the Auto-refresh Customize
configuration dialog box, see option 1.

When you perform either of the two alternative options above, the system starts refreshing the data as scheduled 

and the Configure auto-refresh button changes to  button ( ). To stop the auto-refresh, click Stop auto-refresh
the  button or click the arrow next to it and click  on the auto-refresh menu.Stop auto-refresh Stop

Data Refresh
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You can do inline editing (see the  section below) as well as open the content of a cell in a separate Inline Editing
editor (see the  section below).Cell Editor

When you make any changes to the data and save them using steps described in this section, the changes apply 
to the database itself. Prior to saving the changes, you can preview the SQL script that the system sends to the 
database to apply the changes there. To see the SQL script, after making changes and before saving or 

discarding them, click the  button ( ) in the bottom toolbar. The Preview Changes window opens, in Script
which you can only view the SQL script and copy it, if necessary:

Inline editing is when you modify the content right in the cell. To edit a cell inline, in the table do one of the 
following:

Double-click the cell.

Click the cell to set focus to it and press .Enter

Right-click the cell and click  on the context menu.Inline edit

The cell becomes editable, now you can change its value.

To set the cell value to NULL, right-click the cell and click  on the context menu.Set to NULL

To save the changes, click the  button ( ) in the bottom toolbar. To discard the changes, click the Save

 button ( ) in the bottom toolbar.Cancel

NOTE: Both the  and l buttons become editable only when you make changes in a cell and then jump Save Cance
to another cell.

To edit data in a cell using a separate editor, do one of the following:

Data Viewing and Editing

Inline Editing

Cell Editor
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Right-click the cell and click  on the context menu.Edit cell

Click the cell to set focus to it and press  or click the  Shift+Enter Edit cell value in separate dialog/editor

button ( ) in the bottom toolbar.

For cells of CLOB/BLOB data format, this action opens the contents of the cell in a new tab. For all other formats 
except CLOB/BLOB, this action opens a properties window for the cell:

The window displays properties of the column in the  section and provides the  section where Column Info Value
you can modify the value of the cell. Edit the value as required and click . To set the value to NULL, click Save Set 

. To continue editing the cell in a separate editor (tab), click .NULL Open Editor

NOTE: DBeaver has full support of CLOB/BLOB data types. You can view values, edit them and save back to the 
database. You can open CLOB/BLOB value in a separate editor (press  on a selected cell). You Shift+Enter
can save/load LOB value to/from regular files. DBeaver can recognize that some BLOB column keeps images (gif, 
png, jpeg, bmp). In this case DBeaver shows LOB contents as image. It is convenient to open value view panel 
(press ) and browse images.F7

Adding, Copying and Deleting Rows
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You can add an empty row below the row in focus. To add an empty row, click the  button ( ) in the Add new row
bottom toolbar. Use inline editing or open cell values in a separate editor to populate them with data (see the 
sections above).

You can copy any row or several rows currently in focus. To copy rows, highlight one or more rows and click the 

 button ( ) in the bottom toolbar. The duplicate rows appear below the rows in focus.Duplicate current row

To delete a row or rows, set focus to the rows and click the  button ( ) in the bottom toolbar. Delete current row
The rows are colored red, which means that they are marked for deletion and will be deleted when you save the 
changes.

To save any of such changes, click the  button ( ) in the bottom toolbar. To discard the changes, click Save

the  button ( ) in the bottom toolbar.Cancel

To copy the content of one or several cells to the clipboard in TAB-delimited format, press  or right-click Ctrl+C
the cell or cell selection and click  on the context menu. Then you can paste the copied selection into some Copy
spreadsheet editor (similar to Excel).

DBeaver provides the advanced copy option that allows configuring additional copy settings (copy with column 
names/row numbers, configure delimiter and choose value format). To copy cells with additional settings, press Ctrl+Shift+C
or right click the cell(s) and click  on the context menu.Advanced Copy

Pressing  on a cell pastes the copied content into the cell applying appropriate data type conversion. The Ctrl+V
 option on the context menu or pressing  pastes several cells.Advanced Paste Ctrl+Shift+V

To be able to persist column value changes, a table must have some unique key (primary key or unique index). 
Some databases (Oracle, DB2, PostgreSQL) support a special virtual unique column that DBeaver can use to 
save changes. In other cases, you can define a virtual key – a set of columns that forms a unique combination of 
values. When you try to save changes in a table without a unique key, DBeaver displays the following error 
message:

To use all columns as the virtual key, click . To create a custom key, click . Use All Columns Custom Unique Key

Alternatively, to create a custom unique key, you can click the  ( ) button in the bottom toolbar and Configure
then click  on the Configure menu. The Define virtual unique identifier window opens:Define virtual unique key

Copying/Pasting Cells

Defining Virtual Keys
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To define the key, select some of the columns or click  and then click . To remove a unique key from Select All OK
a table, click the  button in the bottom toolbar and then click .Configure Clear virtual unique key



DBeaver User Guide 21.0. Page 49 of 334.

Panels provide additional space in the  in which you can manipulate with data. The panels are handy if Data editor
you work with complex types (structures, arrays), or long text data, or BLOBs. Panels appear as tabs in an 
additional pane in the right part of the Data tab:

This additional pane appears only when you open one of the four panels:

Calc

Grouping

Metadata

Value viewer (default)

To open panels, click  in the bottom toolbar. By default, the Value viewer panel opens. Alternatively, you Panels
can open the Value panel by pressing  on a cell. To open the other panels, click the down arrow next to the F7

 button and click the name of the panel on the menu:Panels

Panels
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Panels also open if you try to inline-edit a cell with a complex data type.

To close panels, click the  button again or click the standard Close (cross) icon in the upper right corner of Panels
each panel.

You can also show and hide panels by clicking the  button ( ) in the bottom toolbar and then Configure Toggle 
 on the Configure dropdown menu.result panels

The Value viewer panel displays just one value that is currently in focus and allows editing it.

The toolbar of Value panel contains the following buttons:

Value Viewer
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Button Name Description

Content 
viewer 
settings

Opens a menu with a set of options for content view change.

Save to 
file...

Allows saving the content to a local file. : This button is only available for XML, JSON and Binary NOTE
content.

Load 
from 
file...

Allows uploading data from a local file. : This button is only available for XML,JSON and Binary NOTE
content.

Apply 
cell 
value

Displays in the data table the changes made in the Value viewer. : This button does not save NOTE
changes made to the database. To save the changes in the database, you need to use the  button Save
in the bottom toolbar of the ..Data Editor

Auto-
apply 
value

Еnables automatic display of changes made in the Value viewer in the data table. When auto-saving is 
enabled, the changes appear in the data table at the same time when they are made in the Value 
viewer. : This button does not save changes made to the database. To save the changes in the NOTE
database, you need to use the  button in the bottom toolbar of the .Save Data Editor

The Metadata panel displays metadata for each cell in the row containing the cell currently in focus. You can just 
view the metadata.

The Calc panel is useful for getting basic statistics across data in several columns and rows:

Metadata Panel

Calc Panel
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You can select several columns and rows in standard ways - by pressing and holding the left mouse button or by 
clicking cells while holding the  or  keys. The panel updates dynamically to shows statistics for the Ctrl Shift
selected data.

To see data grouped by columns, click the Group by columns button ( ). To remove the grouping by columns 
and see summary values for all columns, click the same button again.

By default, the panel applies and displays results for two functions –  and . To add other Count Count Distinct

functions, click the  ( ) button in the toolbar of the panel or right-click one of the rows in the Add function
Aggregate panel and click  on the context menu and then click the name of the function. The following Add function
functions are available:

Sum

Average

Minimum

Maximum

Median

Mode

To remove an individual function, click the function and then click  ( ) in the toolbar of the Remove function
panel, or right-click the function and click  on the context menu. To remove all functions, click Remove function

 ( ) in the toolbar or on the context menu.Reset
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You can copy the value of a particular function to the clipboard - right-click the row and click  on the Copy Value
context menu.
You can also copy all functions with their values - right-click in the table and click  on the context menu.Copy All

The Grouping panel provides tools to calculate statistics based on a table of a custom SQL query. It uses GROUP 
BY queries to extract unique values for COUNT (default), SUM, AVG, MIN, MAX and other analytics functions 
displaying the results in dedicated columns.
To obtain the grouping results for one or more columns of a data table, open the Grouping panel, then, in the 
results table, put the cursor onto the data type icon of the table header so that the cursor turns into a hand pointer (

), and drag-n-drop the column(s) onto the panel:

If you add several columns to the panel, DBeaver groups data in the order in which the columns go and calculates 
statistics based on the grouping.

Grouping Panel
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1.  

2.  

3.  

By default, the COUNT function is used. You can add other functions as well. To add a function:

Click the  button in the panel`s toolbar.Edit grouping columns

In the Grouping Configuration window, in the  area, click , then type the function into the new Functions Add
row:

You can use auto-complete options DBeaver provides.

You need to indicate the column name in brackets. COUNT is the only function that supports  instead *

of column name.

Click :OK
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1.  

2.  

To remove a function, in the same Grouping Configuration window, click the function and click  and then Remove
. To remove all functions, click  and then .OK Clear OK

You can also add or remove columns using the same Grouping Configuration window. To add a column:

Click the  button in the panel`s toolbar.Edit grouping columns

In the Grouping Configuration window, in the  area, click , then type the column name into the Columns Add
new row (you can use auto-complete options DBeaver provides), and then click :OK
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For MySQL/MariaDB databases you can also add a column with an expression - the expression will be calculated 
in the resulting column:

To remove a column, in the Grouping Configuration window, in the  area, click the column name, then Columns
 and . To remove all columns, click  and .Remove OK Clear OK

Another way to remove a column is to click the column and then the  button ( ) in the Remove grouping column

panel`s toolbar. Clicking the  button ( ) removes all results from the Grouping panel.Clear grouping
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Note: This functionality is available only in .Enterprise Edition

The default grid view of query resulting data is not very much impressive, especially to business analysts and 
other end users. The  feature lets you quickly and easily turn your SELECT queries' output into a colorized Charts
bar chart.

Note: Analytical Charts present only in DBeaver Enterprise Edition

You can easily visualize your data by creating a chart bar both in  and .SQL Editor Data Editor

Visual representation of vast data permits the analytical reasoning process to become faster and more focused. 
Charts make it easy for analysts to perceive salient aspects of their data quickly.

To build a bar chart in the , press the  button  in the left vertical toolbar of the query results SQL Editor Charts
area.

Managing Charts

Creating Charts In SQL Editor
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A bar chart will be created.
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Charts can be very helpful for visualizing structured analytical data stored as , for example.Views

You can also create a chart for any table but you have to structure its data by sorting and applying various filters to 
its columns first. All the structural changes you make will then affect the chart you build, this way you can adjust 
the chart representation to the desired one.

To build a chart in the , press the  button  in the left vertical toolbar.Data Editor Charts

Creating Charts In Data Editor
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А bar chart will be created.

Note, that by default, the data for axis Y is taken from the first column of the table containing numeric values.
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Such analytical tool as the  also supports the  feature. In a chart built for a table containing Grouping Panel Charts
the grouping results for one or more columns of a data table, you can easily change axes X and axes Y source 
data by switching the columns in the .Charts Editor

To build a chart in , press the  button  in the left vertical toolbar.Grouping Panel Charts

To edit chart settings select the  option in the chart's context menu and the  will appear.Charts... Chart Editor

Creating Charts In Grouping Panel

Editing Chart Settings
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1.  

2.  

1.  

2.  

The following chart settings can be adjusted:

In the  drop down list of available columns select a column whose data will be used on axis X of the Column
bar chart. Make sure you choose unique columns for X axis.

Define a user-friendly axis name in the  text field.Label

In the  drop down list of available columns select a column whose data will be used on axis Y of the Column
bar chart. , that only columns containing numeric data can be used for axis Y.Note

Define a user-friendly axis name in the  text field.Label

You can also set the following chart options:

Sample count - maximum number of columns used for building a chart;

Row count - maximum number of rows used for building a chart;

Setting Axis X

Setting Axis Y

Setting Other Options
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Sample function - an aggregate function where the values of multiple rows are grouped together to form a 
single summary value displayed on axis Y.

The following sample functions are suppoerted:

Name Description

AVG Average value

SUM The sum of all values

FIRST The first value

LAST The last value

COUNT Total count of all values

You can copy a chart to clipboard by selecting the  option in the chart's context menu.Copy to clipboard

You can export а chart into PNG format by selecting the  option in the chart's context menu.Save as...

You can print а chart by selecting the  option in the chart's context menu.Print...

Copying to clipboard

Exporting Charts

Printing Charts
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To search for data in the result set, press . The standard Find/Replace search dialog box opens:CTRL+F

You can also use the Find and Replace feature.

NOTE: The system searches only in already fetched rows.

Data Search
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You can generate SQL statements (SELECT/INSERT/UPDATE/DELETE) based on selected rows. To generate 
SQL, right-click the selected rows and click  and then one of the SQL commands on the context Generate SQL
menu:

The SQL result opens in a separate window where you can view and copy it:

SQL Generation
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To use table names in the format '[schema name].[table name]', select the  checkbox.Use fully qualified names
To wrap the SQL query into one line, select the  checkbox:Compact SQL
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Spatial data is a geometry or geography value that can be represented on a map or as a graph. Geometry object 
consists of series of points. .More details

DBeaver's support of spatial data covers the following databases:

PostgreSQL (PostGIS)

MySQL

SQLite (GeoPackage)

H2GIS

SAP HANA

Oracle 

SQL Server 

DBeaver ships with several predefined map tiles. Tiles can be chosen with the combo below the viewer:

Working with spatial/GIS data

Spatial data viewer

Tile layer management

https://en.wikipedia.org/wiki/Spatial_database
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You can choose which tile layers you want to see in the combo in the  dialogue:manage
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In the same manage dialogue, you can add new tile layers, edit layers you added previously, or delete them:
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At this point, you may be wondering what to put in the Layers definition box. Here is a brief explanation.

DBeaver's spatial data viewer uses Leaflet (version 1.4.0 at the moment) under the hood. When providing Layers 
definition, you type the arguments for function L.tileLayer(), which installs a new tile layer.  function in More on that
the official Leaflet documentation. You can also see the definition of predefined tiles to help you get started.

You can also see your geodata on the map if you select the data cell setting "View/Format", then "Set 
columnName format" and among the formats - Geometry. This works for both string and binary types of columns.

String column type to spatial.

Defining custom tile layer

Viewing string or binary data from any Database on a map

https://leafletjs.com/reference-1.4.0.html#tilelayer
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Binary column type to spatial.
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DBeaver supports XML and JSON column types (in relational databases) by using standard JDBC interfaces. This 
feature was added in JDBC4 so you will need JDBC4 compliant driver for your database.

In the Data Editor, you can edit XML/JSON data right in the table cells, however, a big amount of data may require 
a larger editor, you may want to save XML/JSON scripts to a local file or upload this type of data from a local file.

To open the full-size XML/JSON editor click the cell containing data in XML/JSON format and press +Shift Enter
.

By default the editor opens on JSON tab, open XML tab to modify XML data.

To auto-format XML/JSON script press + +  keyboard buttons.Ctrl Shift F

Working with XML and JSON
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Use +  keyboard shortcut to save the changes made.Ctrl S

You can also edit XML/JSON content, save it locally and upload it from a local file with the help of  panel Value
toolbar.

To upload data from a local file, press the  button .Load from file...

To save the content to a local file, press the  button .Save to file...

To switch between the formats, press the  button  and select the format.Content viewer settings
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Use  feature that wraps the text within a screen.Word Wrap

Use  feature to automatically change the appearance of XML/JSON script (fix spaces around Auto Format
operators / commas, fix indentation, etc) and make it more readable.
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To learn more about  panel, see .Value Panels
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The DBeaver formatting functions allow you to set up database locale and change datasource format settings. 
This feature can be very useful on database migration, for example.

To change data format settings use option Window -> Preferences in main menu.

In the Preferences dialog box go to Editors -> Data Editor -> Data Formats.

Managing Data Formats
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Or, in the  right-click a connection and select  menu option.Database Navigator Edit Connection
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In the right area of the opened  dialog window go to Data editor -> Data Formats and Data formatting preferences
select the  check box in the left area to customize the data format settings.Datasource settings
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Data format profiles allow you to apply a set of data format preferences to the whole current project by one click.

To create a data format profile press the  button. In the opened dialog window press button Manage Profiles New 
, define the name and press .Profile Create

To delete a data format profile press the  button, then in the opened dialog window select the Manage Profiles
profile you want to delete and press the button .Delete Profile

Data Format Profiles
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The following groups of data format settings can be adjusted:

Changing Data Formats

Locale
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To define this setting select a language, country and variant if available.

Native Date/Time Mode
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Select  check-box and the data format originally built-in to the datasource will be used.Use native date/time format

You can change the format of the following data types:

Data Type Format
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The format of the following data types can be customized:

Date

Time

Timestamp

Numbers

The default value for this data type is .yyyy-MM-dd

Pattern Description

yyyy or y Year of era (4 digits)

yy Year of era (2 last digits)

YYYY Week year

M Month in year without leading zeros

MM Month in year

Date
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MMM Short month name in year

MMMM Month name in year

D Day in year

d Day in month without leading zeros

dd Day in month

E Day name in week

G Era designator

z General time zone

Z RFC 822 time zone

The default value for this data type is HH:mm:ss

Pattern Description

H Hour in day (0-23) without leading zeros

h Hour in day in am/pm (1-12) without leading zeros

HH Hour in day (0-23)

hh Hour in day in am/pm (1-12)

a Am/pm marker

m Minute in hour without leading zeros

mm Minute in hour

s Second in minute without leading zeros

ss Second in minute

S Millisecond

ffffff Microseconds

The default value for this data type is yyyy-MM-dd HH:mm:ss

Link on Java date pattern documentation

The following parameters can be configured from this type of data:

Use Grouping - Long numbers can be hard to read if they have too many digits. For example, the factorial of 
30 is 33 digits long! Select this check-box to enable Grouping mode, in which digits are displayed in clumps of 
3 or 4 (depending on the current radix) separated by commas.

Maximum integer digits - Defines the maximum number of digits to the left of the decimal point.

Time

Timestamp

Numbers

https://docs.oracle.com/en/java/javase/11/docs/api/java.base/java/text/SimpleDateFormat.html
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Minimum integer digits - Defines the minimum number of digits to the left of the decimal point.

Maximum fraction digits - Defines the maximum number of digits to the right of the decimal point.

Minimum fraction digits - Defines the minimum number of digits to the right of the decimal point.

Use data type scale for fraction digits - Some numeric columns or parameters may have a predefined scale, 
that is the maximum number of digits to the right of the decimal point. Select this check-box if you want the 
predefined precision to be used.

Rounding mode - Specifies a rounding behavior for numerical operations capable of discarding precision. 
Each rounding mode indicates how the least significant returned digit of a rounded result is to be calculated. 
To learn more, please refer to .Oracle documentation

To change the data type format, change the value displayed in the  area,save the changes made by Pattern
pressing the  button and observe the expected result in the  field.Apply Sample

To restore the default data format settings, press the  button.Restore Defaults

Restoring Default Data Formats

https://docs.oracle.com/javase/7/docs/api/java/math/RoundingMode.html
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Press  link to change data format settings for a particular datasource, then adjust the settings Datasource settings
in the opened dialog box.

Datasource Settings
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To save changes made press .Apply
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You can create multiple SQL scripts for a single connection. Every script opens in its own SQL editor. To open an 
SQL editor for some connection:

Click this connection in the  view and press  or click  on the Database Navigator F3 SQL Editor -> SQL Editor
main menu. Alternatively, you click  on the context menu of this connection. DBeaver opens the SQL Editor
Choose SQL script editor with saved SQL scripts linked to this connection. CLick the SQL script to open it in a 
separate tab.

Click  on the context menu for this connection or on the main menu (Recent SQL Editor SQL Editor -> Recent 
). This opens the latest used SQL editor. You can also open the most recent SQL editor using SQL Editor Ctrl+Enter

shortcut in the Database Navigator view.

If you need to create a new SQL script, on the main menu, click  or press  SQL Editor -> New SQL Editor F3
and then click  in the Choose SQL Script window.New Script

DBeaver uses SQL syntax highlighting which depends on the database associated with the script. Different 
databases have different sets of reserved keywords and system functions.

NOTE: SQL Editor for a connection is different from SQL console for a table or view (right-click the table and click 
) in that, unlike the console, it can save scripts and changes to them.Read data in SQL console

You can see all your saved SQL scripts in the  view in the  folder.Project Explorer Scripts

The SQL editor includes the script panel at the top and results panel at the bottom:

You can open SQL editor preferences by pressing .Alt+Enter

SQL Editor

Results Panel
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The results panel displays tabs with results in various formats. The tabs resulting from script execution represent 
instances of the . You can create, edit and execute SQL scripts in the script panel and then see the Data Editor
results in the result tabs.

The results panel provides  and  views of results.Output Log

The execution  tab contains all queries executed in the current SQL editor:Log

The  tab contains all server-side database messages/warnings generated by a database when you execute Output
queries. This feature is supported only by a few database engines (Oracle, SQL Server and some other ones).

You can modify the layout of the SQL Editor by showing/hiding the results panel and changing the horizontal
/vertical position of the panes.

To toggle (hide/show) the results panel, press  or right-click anywhere in the script pane and, on the CTRL+6
context menu, click .Layout -> Toggle results panel

To maximize the results panel, press , or double-click the results tab name, or right-click CTRL+Shift+6
anywhere in the script panel and, on the context menu, click .Layout -> Maximize results panel

To switch between the script panel and the results pane, press  or right-click anywhere in the script Alt+6
panel and, on the context menu, click .Layout -> Switch active panel

To position both panels horizontally, right-click anywhere in the script panel and, on the context menu, click Layout 
.-> Horizontal

To position both panels vertically, right-click anywhere in the script panel and, on the context menu, click Layout -> 
.Vertical

You can press and hold  and at the same time move the mouse over SQL text. If DBeaver recognizes Ctrl
some identifier as a table/view name, it presents it as a hyperlink. You can click the hyperlink to open this object`s 
editor:

Layout Adjustment

Hyperlinks

Active Database/Schema Selection
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You can change the connection associated with the current SQL editor or change the active database/schema, at 
the same time retaining the SQL text.
To change the connection, press  or click the  box on DBeaver`s main toolbar:Ctrl+9 Active datasource

The Select Data Source dialog box opens. In the tree of connections, click the required connection and then click 
. To disassociate the SQL Editor with any connection, click :Select None

To change the active schema, press  or click the  box in DBeaver`s main toolbar:Ctrl+0 Active Catalog/Schema

The Choose catalog/schema dialog box opens. In the list of schemas, double-click the required schema:

If there are many schemas and they do not fit in the dialog box use the search field to find the schema you need: 

To configure the set of columns to be visible for each schema in the dialog box, click the  button Configure columns

( ).



DBeaver User Guide 21.0. Page 91 of 334.

You can easily associate the SQL Editor with the connection that is currently in focus in the Database Navigator 
(the focus can be on any object of the connection - a table, a folder, etc.) - click the  Set connection from navigator
button in DBeaver`s main toolbar:

The reverse action is also possible: you can set the focus of the Database Navigator to the active connection of 
the SQL Editor - press  or click the arrow next to the  button in Ctrl+Shift+, Set connection from navigator
DBeaver`s main toolbar and then click :Link with editor
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Templates allow you to insert frequently used SQL statements into an SQL script.

To see available templates, press  or right-click the line in the script pane and click Ctrl+Alt+SPACE SQL 
 on the context menu. A box appears with a list of available templates:Template

To apply a template, in the SQL Editor, in the script pane:

Type the template name and press Tab

Right-click the line where you want to insert a template expression, click  on the context menu, SQL Template
and then, in the list of templates, double-click the required template name.
The template SQL statement appears in the script.

To edit/add/remove templates, click Configure () in the bottom toolbar, then click Preferences -> SQL Editor -> 
. For more information about managing templates, please visit .Templates Eclipse Website

Variable Description

${cursor}
Specifies the cursor position when the template edit mode is left. This is useful when the cursor should 
jump to different place than to the end of the template upon leaving the template edit mode.

${year} Takes the current year value

${date} Takes the current date value

${time} Takes the current time value

${dollar} Takes the dollar sign $. Alternatively, two dollar signs can be used: $$.

${user} Takes the user name

${word_selection} Takes the content of the current text selection

${line_selection} Takes content of all currently selected lines

Variable Description

SQL Templates

Standard Eclipse templates:

DBeaver-specific templates:

http://help.eclipse.org/juno/index.jsp?topic=%2Forg.eclipse.jdt.doc.user%2Fconcepts%2Fconcept-editor-templates.htm
http://help.eclipse.org/juno/topic/org.eclipse.jdt.doc.user/concepts/concept-template-variables.htm?cp=1_2_6_0
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${schema} Takes the current schema name

${catalog} Takes the catalog name

${table} Takes the current table name (from the active catalog/schema)

${column} Takes the column name (from the current table)
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The SQL Assist feature provides auto-completion of database object names and SQL commands and other 
keywords in queries.

To perform some object name auto-complete, press  or right-click the required place in the query Ctrl+Space
and click  on the context menu. DBeaver searches for potentially suitable objects in already loaded SQL Assist
database metadata and in the database system tables.

When you start typing an SQL keyword in a statement, DBeaver offers auto-complete options as well.
Another auto-complete function is search for completion only within already entered identifiers - press Ctrl+Shift+Space
.

Also you can press  after asterisk in query like "SELECT Ctrl+Space FROM tableName" or like "INSERT INTO 
)" (brackets are important) (you can use ()[]{} brackets) - the asterisk will be replaced with a list of all tableName (

table columns.

SQL Assist and Auto-Complete
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To format SQL text, select it and press  or right-click the selected text and click Ctrl+Shift+F Format -> 
 on the context menu.Format SQL

To format a script to upper or lower case, highlight the SQL text, then right-click it and click Format -> To Upper 
, respectively, on the context menu.Case / To Lower Case

To comment out an SQL line, press  or right-click the line and click  on Ctrl+/ Format -> Toggle Line Comment
the context menu. To uncomment a commented line, manually remove the commenting syntax, or press the same 
button combination, or right-click the line and click the same item on the context menu.

To comment out a block of text, select the text, then press  or right-click it and click Ctrl+Shift+/ Format -> 
 on the context menu. To uncomment a commented block of text, either manually remove Toggle Block Comment

the commenting syntax or select the same block of text, right-click it and click the same item on the context menu 
or press the same button combination.

SQL Formatting
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You can execute one query, a highlighted portion of a script, or a whole script. You can execute them using:

Shortcut key combinations (see details further in this article)

Tools in the main toolbar: 

Context menu (right-click the query):

DBeaver main menu:

To execute a query under cursor or selected text, press  or right-click the query and click Ctrl+Enter Execute -
 on the context menu. You can do the same using the main toolbar or main menu: > Execute SQL Statement SQL 

. This executes the SQL query under cursor or selected text and fills the results Editor -> Execute SQL Statement
pane with the query results.

To execute a query under cursor in a separate tab, press or right-click the query and click CTRL+\ Execute -> 
 on the context menu. The same can be done using the main toolbar or the main menu: Execute SQL in new tab

SQL Execution
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. This executes the SQL query under cursor or selected text and creates a SQL Editor -> Execute SQL in new tab
new results tab.

To execute the whole script, press  or click  on the context menu or Alt+X Execute -> Execute SQL Script SQL 
 on the main menu or in the main toolbar. This executes all queries in the current Editor -> Execute SQL Script

editor (or selected queries) as a script. DBeaver parses queries one by one using a statement delimiter (“;” by 
default) and executes them consecutively. You can configure the script execution behavior in the SQL editor 
preferences (Right-click the script and click  on the context menu).Preferences

To execute a script opening each query results in a separate tab, press  or click Ctrl+Alt+Shift+X Execute -> 
 on the context menu or Execute Statements In Separate Tabs SQL Editor -> Execute Statements In Separate 

 on the main menu or in the main toolbar. The executes all queries in the script, but opens multiple result Tabs
tabs. Each script query is executed in a separate thread (that is, all queries are executed simultaneously). NOTE: 
Be careful with this feature. If you execute a huge script with a large number of queries, it might cause unexpected 
problems.

Single query may generate several result sets represented by tabs. These tabs are linked to the query they are 
executed from.

To close an individual tab, press  or middle-click on a tab header.CTRL+Shift+\

To close all tabs expect current, click  on the context menu of this tab.Close all result tabs except this

To close all tabs of desired query, click  on the context menu of this tab.Close all result tabs of same query

Tabs are named in a form of , where:Results < > (< >)A B

A is an index of query

B is an index of result set of this query

Tabs can be moved around by dragging them with mouse and pinned using  on the context menu of Pin tab
desired tab. Pinned tabs are stacked on the left, can be moved among other pinned tabs, but can't be mixed with 
unpinned tabs, also pinned tabs can't be closed without being unpinned first and can't be overwritten by executing 
a query in it (by making this tab active).

You can use dynamic parameters in your SQL queries. The parameter format is :name. When you execute a 
query which contains dynamic parameters, DBeaver displays a dialog box in which you can fill the parameter 
values:

Result tabs

Naming

Pinning

Dynamic Parameter Bindings
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You can also use anonymous parameters (?), but you will need to enable them in SQL editor preferences:

You can open SQL editor preferences by pressing .Alt+Enter

SQL Expression Evaluation
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To evaluate an SQL expression, right-click the expression and click  on the Execute -> Evaluate SQL expression
context menu. This command basically performs a query of  type:SELECT [expression] FROM DUAL

If you want to know how many rows an SQL query will produce, you need to apply the Row Count feature – 
highlight and right-click the SQL text and then click  on the context menu:Execute -> Select row count

Row Count

Query Export
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It might be useful to export a query if you have a very long-running query and you do not need to see its results in 
the results panel. You can directly export the current query results to a file/table by right-clicking the query and 
then clicking  on the context menu:Execute -> Export From Query

The Data transfer wizard opens. Go through its steps to complete the export of the query.

You can use special commands in SQL scripts.
These commands are executed on DBeaver side, not on server-side.

Name Description

@set var = value Sets default value for SQL parameter

@echo text Prints string into server output viewer

@include file Includes script file from file system

Client-side commands
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To select the current query row count, press .Ctrl+Alt+Shift+C

To open the definition of the database object currently in focus (under cursor) in a viewer/editor, press .F4

Miscellaneous
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If a database driver supports execution plan visualization, you can see the execution plan of the current query 
(under cursor) by pressing  or clicking  on the context menu or in the main Ctrl+Shift+E Explain execution plan

toolbar:  The execution plan command generates a tree of query execution as one of the result tabs and is 
convenient in estimating if the query/script is quick/optimal enough:

You can click the rows of the execution plan to see their details (statistics) in the panels below and to the right of 
the plan.

To reevaluate the plan, click the  button ( ). To see the source script on which the plan is based, click Reevaluate
the  button ( ).View Source

In DBeaver  you can use advanced (graph) execution plan visualization.Enterprise Edition
This visualization shows most expensive (cost-based) plan nodes. You can hide all irrelevant nodes, see node 
details, use horizontal or vertical pln layout, export it to image or save as json to pass plan information to a 
colleague.

Query Execution Plan

Execution Plan

Simple plan view

Advanced plan view 
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Note: This functionality is available only in .Enterprise Edition

Query Builder is a user-friendly visualization tool that will help you make sense of your complex database designs. 
It can be useful when you need to understand the various relationships between different tables. Also, it can be 
helpful for those who is not much familiar with SQL scripting or if you don't want to insert script commands 
manually. The tool creates SQL scripts automatically based on visual schema you create.

*Note: Visual Query Builder presents only in DBeaver Enterprise Edition

To open  click the  button in the  tool bar.Visual Query Builder Open Query Builder SQL Editor

The  will appear on the right.Visual Query Builder

Visual Query Builder

Opening Visual Query Builder
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Start creating a query from selecting query data source: drag-and-drop tables you want to work with from the 
 pane into the  area. All the connections existing between the tables will Database Navigator Visual Query Builder

be shown automatically.

Creating Visual Query
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To create a new join between the tables press the left mouse button when the cursor is over the column of one 
table, holding the right mouse button pressed drag the cursor to the column of another table and release the right 
mouse button. The connection between the selected columns of the tables will be created visually and in the SQL 
script a new join will be added.
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To remove a join between the tables click on it. The connection will be highlighted. Then, press  or use Delete
the  option in the context menu. The visual connection will be removed and the corresponding join will be Delete
automatically removed from the SQL script area.

To build a SELECT query you need to select columns in the tables you added. To select a column click the check-
box next to its name - the column will be added to the  tab of the  and SELECT Columns Query Settings Editor
query will be added to the SQL script area automatically.

Visual Query Builder also allows setting query conditions and adjust representation of query results by means of 
.Query Settings Editor

To open  use  button  in the vertical tool bar on the left.Query Settings Editor Visual builder query settings

Query Settings window contains five tabs described below.

Adjusting Query Settings
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Columns tab of the  contains all the columns you added by selecting column names in Query Settings Editor Visual 
 main window. In this tab you can add and remove columns using  and  buttons Builder Add Remove

correspondingly.

To add a column, press  button  and a new instance will be added to the table. Click on the first cell in Add
 column and select a column from the list of available columns displayed in the dropdown Column or Expression

list appeared.

To remove a column, click on the row containing its name and press the  button  on the right.Remove

To change the display order of columns in the result table use  buttons .Move Up/Down

You can also define a user-friendly name of the column to be displayed in the result table. To set a user-friendly 
name click on a cell in  column and insert the name. The change will be immediately displayed in the SQL Alias
script area.

Columns
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If you want a  condition to be added to your expression, then you can click on the checkbox in the column grouping
row. The expression will update automatically. The other previously selected columns will become aggregate. If 
there are no other columns, then the expression COUNT(*) will be automatically added.

You can select other aggregation functions from the drop-down list. Or enter your own version in the cell.

When removing columns from the list, they will be removed from the grouping expression as well. When adding 
new columns to the list, it is added to the grouping expression.

Conditions tab is used for managing query conditional expressions.

Conditions
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To add a new conditional expression use the  button  on the right - a new instance will be added and the Add
default conditional expression WHERE will be added to the SQL script area automatically. This default conditional 
expression can be then adjusted to the one you need:

Left Operand setting defines the left operand of the conditional expression. To set the left operand, click the 
cell in the  column and a drop down list of all available columns will be displayed. Select a Left Operand
column you want to use as the left operand in your conditional expression or insert a digit.

Operation setting defines the comparison rule between the left and the right operands of the conditional 
expression. To set a comparison rule, click the cell in the  column and select the rule you need from Operation
the drop down list appeared.
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Right Operand setting defines the right operand of the conditional expression. To set the right operand, click 
the cell in the  column and a drop down list of all available columns will be displayed. Select a Right Operand
column you want to use as the left operand in your conditional expression or insert a digit.

To remove a conditional expression, click on the row containing the expression and press the  button  Remove
on the right.

Joins
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All the joins existing between the tables in  main window are displayed in the  tab of Visual Query Builder Joins
.Query Settings Editor

Joins cannot be added or removed by means of , however, the following join settings can be Query Settings Editor
adjusted here:

Type - defines the type of the join. Click the cell in the  column - a drop down with available join types Type
will be displayed. Select the required option from the list by clicking on it.

Alias - defines a user friendly name of the join. To define this setting click on the cell in  column and input Alias
the name.
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In  tab you can set the order of rows in the result table.Sorting

To add a new sorting condition press the  button  on the right and the default conditional expression Add
ORDER BY will be added to the SQL script area automatically. This default conditional expression can be then 
adjusted to the one you need:

Once a new condition is added, click the first cell in  column and a drop down list of Conditions or Expressions
all available columns will appear. Select the required column by clicking on its name.

Sorting
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In  column you can define whether the rows of the selected column should be sorted in ascending or Order
descending order in the result table. To set the order, click the cell in  column and select the required Order
option from.The order by command will be added to the script.

To remove a condition use the  button  on the right.Remove

In  tab it is possible to:Miscellaneous

Miscellaneous



DBeaver User Guide 21.0. Page 115 of 334.

Enable or disable the automatic generation of aliases for tables by selecting the  check-box.Add table aliases

Disable auto-completion for table names by selecting the  check-box.Use fully qualified table names

Enable Autosave on SQL-editor switch by selecting the  check-box.Autosave on SQL-editor switch

To execute a query, use  button  to get the results in the same tab or Execute SQL statement Execute SQL 

 button  to get the results in a new tab. Both buttons are located in the statement in new tab Visual Query 
 vertical toolbar.Builder

Executing Visual Query
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You can save scripts to a predefined space in the currently active project or somewhere in the file system.

To save a script to the current project space, just press  or right-click the script and click  on the Ctrl+S Save
context menu:

You can find the script saved this way in the  view in the  folder.Project Explorer Scripts

To save a script to the file system, right-click the script, click  on the context menu and File -> Export SQL script
then select the folder in the file system. You can also, click  on the main menu:SQL Editor -> Export SQL script

Script Management

Saving Scripts
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Unsaved data are highlighted in color on the left side of the editor, as well as an asterisk in the name of the script.

To load a script stored in the file system to the SQL Editor, press , or click CTRL+SHIFT+O SQL Editor -> Import 
 on the main menu, or right-click the script panel and click  on the context menu:SQL script File -> Import SQL script

To rename a script, right-click anywhere in the script panel, click  on the context menu File -> Rename SQL Script
or press :CTRL+F2

Loading Scripts

Renaming Scripts
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Then enter the new name in the Rename SQL script dialog box and click :OK

If you want to revert all changes made to the current SQL script and return it to its initial state (reload from disk), 
right-click anywhere in the script panel and click  on the context menu.File -> Revert

In some cases you might want to execute a query and do not save it in a script. For example when you read table 
data using "Read data in SQL console" or open procedure/function source from DDL editor. SQL console doesn't 
has an associated .sql file. Its contents will be lost when you close it.

Reverting Changes

SQL Console
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DBeaver supports the following commands:

Command Database Description

@set var = value All
Sets a script variable.
You can use expressions as a value. Variables can be used as SQL queries input 
parameters.

@unset var All Unsets a script variable.

@echo message All Prints message to output log. You can use a macro in message (for example ${var}).

@include fileName All

- Executes a specified file name,
- Can be used in scripts, 
- Opens a new SQL console with the specified file and processes SQL queries as in a 
regular SQL editor.

source fileName MySQL The same as @include but in MySQL CLI syntax

define var = value Exasol The same as @set but in Exasol EXAPlus syntax.

Client Side Commands
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To enable interactive debugging of PL/SQL procedures on a Postgres server, you need to use _plugin . debugger
The _plugin  is a typical interactive debugger delivered as an extension. It requires a shared library debugger
preload in Postgres to operate the shared_preload_libraries parameter in settings. The debugger is developed and 
maintained by EnterpriseDB. Its source code is available for examination and improvement.

The debugger provides the required server API for debugging PL/SQL procedures with:

Breakpoint management;

Step-by-step tracing;

Variable acquisition and management.

If you happen to have a PostgreSQL 12 installed via , then the procedure is quite straightforward:apt

sudo apt install postgresql-12-pldebugger
sudo service postgresql restart

After that, run the following command in the database or databases that you wish to debug functions in:

CREATE EXTENSION pldbgapi;

You can find the source code in . Installation instructions are located in the README file.this repository

Open the source code of the function you want to debug. To toggle breakpoints, place the caret on the line you 
want the function to be stopped at and use shortcut . Alternatively, you can toggle Shift + Control + B

breakpoint with your mouse by clicking on a ruler, as demonstrated in the screenshot below:

PostgreSQL Debugger

Prerequisites for Debugging

Installation

PostgreSQL 12 on Ubuntu-based distros

Installation from source code

Running debugger in DBeaver interface

https://github.com/EnterpriseDB/pldebugger
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NB. You must toggle breakpoints only when  option is  on.Show header not

Then you need to set up a debugging configuration. Locate the downward-facing arrow right to the bug icon, click 
on it, then

Debug As -> :Database Debug

The  dialog opens. Set up input values in the table .Edit Configuration Function parameters
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Click on  button, and you are ready to go!OK

The usual buttons essential for debugging such as  and  are located here:Step Over Continue
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ER diagrams appear on the rightmost tab of the :Database Object Editor

Entity Relation Diagrams (ERD) are graphic presentations of database entities and relations between them. 
DBeaver allows viewing diagrams of existing tables and whole database schemas, see Database Structure 

, as well as create custom diagrams, see .Diagrams Custom Diagrams
By default DBeaver uses  notation.IDEF1X

Both types of diagrams provide the same tools to adjust their view and structure. They can be printed and 
exported to image file formats.

You can use one of the two tools to select elements in diagrams:

Select – supports both, single and multi-select modes. To select a single element (table, connection, entity 
inside a table) in a diagram, just click that element. To select multiple elements, similar to using the Marquee 
tool, click outside the first element and draw until all elements you need are in focus:

ER Diagrams

Selection of Elements in Diagrams

https://en.wikipedia.org/wiki/IDEF1X


DBeaver User Guide 21.0. Page 125 of 334.

NOTE: All changes to existing database schemas cannot be saved and are intended for exploration purposes only.
You can do the following structure changes in diagrams.

Add new tables to a diagram by drag-n-dropping them onto the diagram field from the .Database Navigator

Rearrange tables in the diagram by dragging them all over the space. You can select several tables and drag 
them to a new location.

Auto-arrange tables into a compact view after manual rearrangements: click the  ( ) in the Arrange Diagram
toolbar or on the context menu (right-click anywhere on the diagram tab).

(Available for  only) - connect tables with a connector: click the  button ( ) in Custom Diagrams Show Palette
the upper-left corner of the diagram tab and then, in the Palette panel, click :Connection

Now click the tables that you want to connect with each other in turn one by one, and then to stop the 
connection line double-clicking the last table.

(Available for  only) - remove tables and connections: right-click the table or conection and Custom Diagrams
click  on the context menu or just click the table or connection and press .Delete Delete

Structure Adjustment
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You can adjust the view of any diagram in the following ways:

Enable/disable the diagram grid: Click  ( ) in the toolbar.Toggle Grid

Modify attributes visibility: Right-click the diagram and, on the context menu, click  and then Show Attributes
one of the options:

All - all attributes

Any keys - primary and foreign keys

Primary key - only primary keys

None - no attributes

Modify attributes presentation: Right-click the diagram and, on the context menu, click  and then View Styles
one of the options:

Show Icons

Show Data Types

Show Nullability

Show Comments

Show Fully qualified names

Change the color of entities/notes: Right-click the header of the entity or comment and then click  on Set color
the context menu. Then you can select the color and click .OK

For elements located in front of/behind others, bring an element to front or send to back: Right-click the 
element and then click  /  on the context menu.Bring to front Send to back

Zoom the diagram in/out: Click the /  buttons or choose the scaling value in the dropdown Zoom In Zoom Out

list in the toolbar: 

To see changes made to the database schema by other users, you might need to refresh the diagram: click 

 ( ) in the toolbar.Refresh Diagram

You can create notes only in . To create a note, click the  button ( ) in the upper-Custom Diagrams Show Palette
left corner of the diagram tab, then, in the Palette panel, click  and then click anywhere in the diagram tab. Note
Now you can double-click  box to enter the note text:Note

View Adjustment

Refresh

Notes
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To search among entities of a diagram, click the  button ( ) in the toolbar, then type in the search Search items
combination. The entities that contain the search combination are highlighted in the diagram. To remove the filter, 
click the cross icon next to the search field.

You can export (save) a diagram as an image (PNG, GIF, BMP formats) or as a file in GraphML format. To export 

a diagram, click  ( ) in the toolbar.Save diagram in external format

To print a diagram, press  or click  ( ) in the toolbar.CTRL+P Print Diagram

To modify the diagram settings, click  ( ) in the toolbar.Configuration

Search in Diagram Entities

Diagram Export

Diagram Printing

Settings
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You can view a database structure in the standard ERD (Entity Relation Diagram) form. ER diagrams are available 
for all tables and schemas (databases).

ER diagram for a table shows the table itself and its relations with other tables inside the schema. To view the ER 
diagram for a table or view, double-click the table or view in the  and then, in the Database Navigator Database 

, switch to the  tab:Object Editor ER Diagram

To view the ER diagram for a full database schema, double-click the schema name in the Database Navigator or 
the previous node in the path (usually - ):Tables

Database Structure Diagrams
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NOTE: Table and schema diagrams are read-only. You can rearrange the layout, drag-n-drop elements inside a 
diagram but you cannot save the changes state or delete/add anything. This is because the diagrams represent 
the actual state of databases.



DBeaver User Guide 21.0. Page 130 of 334.

1.  

You can create custom ER diagrams that can contain any tables, relations and notes.
However, even custom diagrams may contain only real existing database entities (tables).

You can create a custom diagram in one of the ways:

On the DBeaver main menu, click . Then in the new diagram wizard, click File -> New DBeaver -> ER Diagram
, and then :Next

Custom Diagrams



DBeaver User Guide 21.0. Page 131 of 334.

2.  In the  view, right-click the  node and then click  on the Project Explorer ER Diagrams Create New ER Diagram
context menu.

In both cases, in the Diagram Create Wizard, specify the diagram name and (optionally) choose initial diagram 
contents (set of tables):

The new diagram appears in a separate editor. Now you can drag-n-drop any number of tables onto it. You can 
add tables from different connections and even different database type (for example, combine Oracle and MySQL 
tables in one and the same diagram).
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1.  

2.  

3.  

You can also add notes and custom relations (associations) using the ERD palette on the left side of diagram tab, 
see details in  article. For example, to create a diagram similar to the one shown at the beginning of ER Diagrams
this article, you need to:

Add required tables and relationships between them and move them around to create a well-shaped structure 
(see  section of the  article).Structure Adjustment ER Diagrams

Add notes (see the  section of the  article).Notes ER Diagrams

Stretch the notes to cover the intended tables, then send the notes to back, and then set color to the tables 
and notes (see the  section of the  article).View Adjustment ER Diagrams

Undo/redo functions are fully supported in diagram editing.
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DBeaver provides:

File search (search among file contents)

Database full-text search

Database metadata search

To use search, click the Search button in the main toolbar:

Please see dedicated articles for information about search of different types. This article describes common 
features of the three search types.

Search results for any of the search types appear in a separate Search view. The following image shows the 
Search view for the database full text search:

The view contains a toolbar that provides common tools for all types of search as well as specific tools for the File 
Search type. The following are common tools:

Button Name Description

Run the 
Current 
Search 
Again

Repeats the search the results of which are displayed in the Search view

/
Cancel 
Current 
Search

- Active state (red) indicates that the search is still in progress and appears if the search takes some 
time to complete. Clicking the button in this state stops the current search.
- Inactive state (grey) indicates that the search is complete. The button in this state is non-actionable.

Show 
Previous 
Searches

- Clicking the button itself opens the Previous Searches window.
- Clicking the arrow next to the button opens a dropdown menu.
See the  section further in this article.Search History

Pin the 
Search 

Ties the current search results to the Search view. If you click this button, the current results stay in 
the view while the results of the next search appear in a new Search view. Otherwise, every new 

Search

Search View
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View search replaces the previous results with new results.

For information about specific tools of File search, see the  article.File Search

If the search is short, the results appear almost instantly. But if it takes some time, the Search view indicates the 
progress in the following ways:

The  button in the toolbar has the Active state ( )Cancel Current Search

The progress bar appears in the bottom-right corner of the view indicating the process: 

The button to show the search progress in a separate view ( ) appears in the bottom-right corner of the 
view next to the search progress bar. Clicking the button opens the Background Tasks view:

DBeaver stores the history of search queries made during the current session. You can reopen the Search view 
with results of a previous search query. You can also remove individual queries and clear the history. To manage 

the search history, use the  button in the toolbar ( ).Show Previous Searches
To open the results of a previous search query, do one of the following:

Click the arrow next to the  button in the toolbar and then click the query in the Show Previous Searches
dropdown list:

Click the  button itself or the arrow next to it and then  on the dropdown menu Show Previous Searches History
to open the Previous Searches window. Then, in the window, click the query and then either  to open it Open
in the active Search view or  to open it in a new view:Open in New

Search History
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1.  

2.  

3.  

To remove one or more previous search queries:

Click the  button in the toolbar or click the arrow next to it and then  on the Show Previous Searches History
dropdown menu. The Previous Searches window opens.

Click the query to remove or select several of them by clicking and simultaneously holding the  key.Ctrl

Click .Remove

To clear the history by removing all previous queries, click the arrow next to the  button in Show Previous Searches
the toolbar and then click  on the dropdown menu.Clear History
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To search file contents for a string, click the Search button in the main toolbar or the arrow next to the Search 
button and then  on the dropdown menu:File Search

The Search window opens displaying the File Search tab:

You can apply case sensitive search, search by regular expressions, search among particular file types (File name 
 field), and use the find and replace function.patterns

After you click , the results appear in a  view. The results represent a tree or list of files with the Search Search
search combination highlighted:

File Search
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The toolbar of the Search view for File search provides more tools in addition to those available for all search 
types:

Button Name Description

Show Next / Previous 
Match

Open the file in a separate viewer and move the highlight to the next/previous match, 
respectively

Remove Selected 
Matches

Removes selected row (row in focus) of the results

Remove All Matches Removes all results in the view

Expand/Collapse All Expand/collapse the tree of results

The view also provides a view menu (click the  button ( ) in the upper-right corner of the view) that View Menu
contains the following items:

Menu item Description

Show as List Presents the results in the form of list

Show as Tree Presents the results in the form of tree

Filters Opens Search Filters dialog box

Preferences Opens the Preferences window on the Search page

Double-clicking a results row opens it in a separate viewer.
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To do full text search in the database contents, click the arrow next to the Search icon in the main toolbar and then 
click  on the dropdown menu:File Search

Alternatively, you can click the  button on the main menu and then click the  tab in the Search Search DB Full-Text
window:

Now you need to choose the database connection or database objects against which to run the search – expand 
the tree in the  field to the database connections level or further down and select the checkboxes next Databases
to the required connections or database objects.
NOTE: The  button is enabled only when you select the right level of checkboxes – database connections Search
or lower nodes.

You can apply case-sensitive search, fast search and search in numbers and LOBs.

After you click , the results open in a  view:Search Search

DB Full-Text Search
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Double-clicking a row in the Search view opens the respective object in a dedicated .Database Object editor
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To search for database metadata, click the arrow next to the  button in the main toolbar and then click Search DB 
 on the dropdown menu:Metadata Search

Alternatively, you can click the  button on the main menu and then click the  tab in the Search Search DB Metadata
window:

Now you need to choose the database connection against which to run the search – expand the tree in the 
 field to the database connections level and click the required database connection.Objects Source

In the  field, you can select the database objects among which DBeaver will run the metadata search Object Types
– select or clear the checkboxes.
You can specify if the metadata should start with or contain or be similar to the search combination (  Name match
field). You can also set the maximum number of results to display (  field) and apply  Max results Case-sensitive
search.

After you click , the results open in a  view:Search Search

DB Metadata Search
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Double-clicking a row in the Search view opens the respective object in a dedicated .Database Object editor
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You can compare two schemas/databases structure and generate report as:

DDL script (series of create/alter/drop statements)

Diff diagram (sort of ER diagram)

Liquibase change log

Liquibase change report (json, yaml or plaintext)

Select two objects (schemas, databases or tables) you want to compare

Open context menu

Open sub-menu Compare/Migrate

Click on  elementCompare/Migrate Schema

Re-validate that you chosen right objects to compare. You can also specify which changes to process: creates, 
drops, alters. By default all change types are enabled.

Schema compare

Schema compare/migration

Selecting objects to compare

Compare settings
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Also you can exclude the specific compared types of objects. For example, if you do not want to see in the final 
result comparison of sequences, views, external keys etc.

Click on  to generate diff report.Compare Schemas

Compare results
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By default DDL diff is generated. It contains series of create/alter/drop statements which will modify schema on the 
right side and thus will make it identical to the schema on the left side.

You can enable/disable particular changes in the tree on the left side of diff page:

You can also switch to another diff report representation (diagram, json, yaml, plaintext).

Some bases (like SQLite and Firebird) do not have catalogs and schemes that could be selected for comparison. 
In this case (and only for these databases), it is possible to compare the entire datasource entirely.

Compare schemaless bases
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1.  

2.  

3.  

4.  

Sometimes you need to compare data from two sources (tables) which have almost identical data with just few 
differences. There may be a plenty reasons to do so: quickly visualize all the differences and navigate through 
them by your sight, to copy differing rows or individual values or export them using .Data Transfer

You will need to choose one or two desired tables in the  - it may be the tables from the Database Navigator
same databases or from different databases or even from different RDBMS (e.g. PostgreSQL and MySQL).

Then choose  #  #  from the menu and the Data Database Compare/Migrate Data Compare
Compare Wizard will appear. Here you can preview selected tables or choose other ones. Then you can 
navigate to the second page.

After reaching the second page one may wonder about the purpose of it - don't worry, it's not that difficult: you 
should choose columns that will be used as a  during comparison (the amount of columns must be unique key
equal). If the  chosen wrong, it may lead to invalid results. By default, if the table has unique key in it, it keys
will be chosen automatically during the initial setup: 

Without unique keys the rows cannot be compared properly, since there's no way to distinguish between 
individual rows.

After reaching the last page, you can tweak limits (e.g. you only care about  first rows) and exclude N

categories of the resulting rows (e.g. you are not interested in modified rows). Also, you can press Save task
button save configuration in a  to use it later, or  it, Task Schedule although it is not very useful right now, but 
we have plans to support exporting results as an SQL script and more.

Data compare

Preparing the tool

Viewing the results
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After finishing the wizard, you can press  button to begin actual process of comparison - it may take some Start
time depending on the databases you're comparing, the amount of data in them, and your network speed (*).

When the results are ready, DBeaver will play  sound, and the editor will open: beep

Here you can examine the differences, swap the panels using  button in the toolbar, or Swap Containers
preview summary including statistics by using  button in the toolbar too. Everything you can do in Show Summary
the regular data editor is it possible to perform here - you can copy data or transfer it to other database, except 
you cannot modify values.

* - Please note that the actual preview is only available when Data Compare is launched through the wizard - 
otherwise only statistics will be written into the .Task Log

This section is under construction. It will include information about the engine's implementation details and more.

Under the hood
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Note: since version 6.2 MockData generator extension is available only in .Enterprise Edition

Sometimes in software development we need to generate mock, but valid, data for testing. Populating a database 
manually is a time-consuming and exhausting process. It can be very complicated when you need to generate not 
just 5–10 users, but thousands of entities of different types. DBeaver Mock Data generator helps you generate test 
data much easier.

Disclaimer: The idea behind Mock Data is to generate mock data in a table but it should NOT TO BE USED 
. Please make sure you have a backup of your database before running IN PRODUCTION ENVIRONMENTS

the Mock Data generation process.

Th following are features of DBeaver Mock Data generator:

Works for all the RDBMS that are supported by DBeaver (DB2, MS SQL Server, MySQL, Oracle, 
PostgreSQL, SQLite, etc.)

MockData generation
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Generates data that matches your database schema:
Generated data matches the database column types.

All base data types are supported.

Constraints (PK, FK, multi-column FK, unique) are supported.

Supports over 20 configurable data generators (constants, randoms, sequences, names, domains, 
addresses, prices, regex based, etc.)

Automatically associates a column with a generator based on the column characteristics

Saves or overwrites old database data

The following are mock data generators for data types with their configurable parameters:

Boolean
Random

Sequence (initial, order)

Date
Random (start, end)

Sequence (start, step, reverse)

Numeric
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Random

Sequence (start, step, reverse)

Advanced (min, max, precision, scale) *

Price preset *

Coordinate preset *

String
Text (template, min length, max length)

UUID

Address *

City *

Country *

Domain *

Email (gender, with surname, numeric suffix) *

Name (gender, with surname) *

Price (country, min, max) *

Regex based random (regex template) *

Credit Card preset *

Email preset *

Gender preset *

HEX Color preset *

IP4 address preset *

IP6 address preset *

Phone Number preset *

Postal Code preset *

Price preset *

Template with parametrized directives for other generators :*

address() - US postal address

city() - one of the world largest cities

country() - country
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domain() - one of the top Internet domains

email(gender,surname) - e-mail address (gender is ALL|FEMALE|MALE, surname is true|false)

name(gender,surname) - personal name (gender is ALL|FEMALE|MALE, surname is true|false)

random(minimum,maximum) - random integer

regex(pattern) - regex based value for the pattern

sequence(start,step) - sequence of integers

NULL values

FK - data from the referenced table according to the constraint
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* These features are available in the  only.DBeaver Enterprise Edition

https://dbeaver.com/
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Dashboards tool allows DBAs and programmers to quickly identify performance, disk space issues, number of 
connections and other important KPIs associated with a single database connection. To learn more about 
database connections, see .Database Connections

By default, DBeaver is delivered with a number of predefined sets of dashboards for such data bases as 
PostgreSQL, MySQL, Oracle and Exasol. Custom dashboards are also supported. To learn more about custom 
dashboards, see Managing Dashboards section below.

Dashboards panel is a collection of real-time dashboards, that is dashboards that are continuously updated. 
Dashboards displayed on the dashboards panel are actually a combination of continiously run SQL SELECT 
queries and charts continiously built on the data fetched.

To open dashboards panel  button  in the main toolbar. The default configuration of the Open Dashboard
dashboards panel for the current database connection will appear. To learn more about database connections, 
see .Database Connections

You can also right-click a connection name in the  editor and select  menu Database Navigator Open Dashboard
option or use keyboard shortcut + + +  and the dashboards panel will be opened.Ctrl Alt Shift B

Dashboards, DB monitoring

Managing Dashboards Panel

Opening Dashboard Panel
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The following controls are available in the dashboards panel toolbar:

Icon Name Description

Settings Allows managing dashboards' configuration.

Add dashboard Allows to add dashboards to the dashboard panel.

Remove dashboard Allows to remove dashboards from the dashboard panel.

Reset dashboards Allows to restart dashboard calculation.

To add a dashboard to the dashboards panel, press  button  in the dashboards panel's toolbar, Add dashboard
choose one of the dashboards from the list of available dashboards and press  button.Add

Adding Dashboards
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Note: Different databases have different sets of predefined dashboards. DBeaver is delivered with sets of 
predefined dashboards for such databases as Postgress SQL, MySQL, Oracle, and Exasol. It is also possible to 
create new custom dashboards, for more details see Managing Dashboards.

You can also add a dashboard by right-click in any place of the dashboards panel and then select the Add 
 menu option.dashboard

To remove a dashboard from the dashboards panel, click on the dashboard you want to remove and press button 

  in the dashboards panel toolbar or select  option in the dashboard's Remove dashboard Remove dashboard
context menu.

Removing Dashboards
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If you want to restart dashboard's calculation you can reset it.

You can reset all the dashboards displayed in the dashboards panel by a single click on   Reset dashboards
button in the dashboard panel's toolbar.

To reset a particular dashboard right-click on it and select  menu option or left click a dashboard Reset dashboards
and press  button in the dashboards panel's toolbar.Reset dashboards

To adjust dashboard representation settings right click on a dashboard and select the  menu option, then, Settings
in the opened dialog change the parameters you want.

Resetting Dashboards

Changing Dashboard Representation
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The following dashboard representation parameters can be adjusted:

Parameter Description

Name Defines a name of a dashboard.

Description
Defines dashboard's description. Use this field to make it easy to understand what kind of information the 
dashboard represents.

Update periods
(ms)

Defines how often dashboard's rendering should be updated. The default value is 1000 ms.

Maximum items Defines maximum number of fetched items. The default value is 300.

View Defines visual representation of the dashboard. The following options are available: Bar, Pie, Time series.

Show legend If this check-box is selected, the legend will be displayed on the dashboard.

Show grid If this check-box is selected, the grid will be displayed on the dashboard.

Show domain 
axis

If this check-box is selected, the domain axis will be displayed on the dashboard.

Show range 
axis

If this check-box is selected, the range axis will be displayed on the dashboard.
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To adjust dashboard's configuration settings right-click on a dashboard, select the  menu option, then, in Settings
the opened dialog box press the  menu option.Configuration

The following dashboard parameters can be configured:

Parameter Description

ID Defines dashboard's ID. Make sure that ID has numeric values in it.

Name Defines dasboard's name.

Database Defines the database driver. To learn moe about database drivers, see .Database Drivers

Defines the data type. The following options are availabe: timerseries (the default option) and statistics. Select 

Adjusting Dashboard Configuration
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Data type timeseries type if you want to track the actual value returned by the server. Select statistics type if your 
dashboard will show historical data.

Calc type

Defines how the data should be calculated. The following options are available: value (the default option) and 
delta. Select value if you're interested in the current value. Select delta if you want to track the difference 
between the current value and the previous one. This may be very useful when you work with statistics data, for 
example.

Value type
Defines the value to be shown on the range domain. The following options are available: decimal (the default 
option), integer, percent, bytes. Choose the value type in accordance with your data, for example, memory 
usage is convinient to be tracked in KBytes.

Interval
Defines time interval to be shown on the domain axis. The following time intervals are available: millicecond(the 
default option), second, minute, hour, day, week, month, year.

Fetch type Defines whether the query should fetch data from rows or columns.

Description
Defines the description of a dashboard. Use this field to make it easy to understand what kind of information the 
dashboard represents.

Queries Defines an SQL query whose fetched data will be used to build the chart displayed on the dashboard.

Default 
view

Defines the default visual representation of a dashboard on the dashboard panel. The following options are 
available: Bar, Pie, Time series(the default option).

Update 
period(ms)

Defines how often the dashboard's rendering should be updated.

Maximum 
items

Defines maximum number of items to be fetched for the dashboard.

Note: Predefined dashboards are read-only and cannot be re-configured, but you can copy them and use as 
templates to create new dashboards with any query and other settings. To learn about creating new dashboards, 
see Managing Dashboards section.

By default, if there is no active connection to the database and you open its dashboards panel, all the dashboards 
on the panel will be empty.

You can force database connection on the dashboard panel's activation by pressing  button  on the Settings
dashboards panel's toolbar and then selecting the  check-box.Connect on activation

If you have several monitors and would like to place a dashboard into a separate screen, you can either detach 
the whole dashboards panel or a single dashboard and drag-and-drop them to any place you want.

To detach the whole dashboard panel right click on the dashboard's tab name and select the menu option.Detach

Setting Connection Prefereces

Detaching Dashboards
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To detach a single dashboard make a double left click over it. You can also right click the dashboard and then, 
select the  menu option, the dashboard will be detached from the panel and you will be able to View Dashboard
move it to any place of your screen.

You can change the representation of a dashboard and view it as a Pie, Bar or Time series. To change the view of 
a dashboard, right click on it and select  menu option.View as

Changing Dashboard View
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To copy a dashboard into the clipboard, right click on the dashboard and use  menu option, the Copy to Clipboard
screenshot of the dashboard will be placed to the clipboard.

If you want to save a screenshot of a dashboard locally in PNG format, right click on it and select the  Save as ...
option in the context menu displayed.

Copying Dashboards to Clipboard

Saving Dashboards
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If you want to print out a screenshot of a dashboard, right-click the dashboard to be printed and select the  Print…
option.

For Time series and Bar dashboard representations the following zooming options are available in the dashboard's 
context menu:

Zoom In

Zoom Out

Zoom Reset

Printing Dashboards

Zooming
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1.  

2.  

3.  

4.  

You can extend the list of predefined default dashboards by creating your own custom dashboards. This section 
describes dashboards' list management.

You can create a new custom dashboard either from scratch or from any of already existing dashboards.

Press  button  in the dashboards panel toolbar.Settings

In the opened dialog box click  button.Manage...

In the  window click  button.Manage dashboards New dashboard...

Set up all configurational parameters as required and press . To learn more about dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

Managing Dashboards

Creating Dashboards

To create a dashboard from scratch:
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1.  

2.  

3.  

4.  

Press  button  in the dashboards panel toolbar.Settings

In the opened dialog box click  button.Manage...

In the  window select any of the existing dashboards from the list and click .Manage dashboards Copy

Adjust all configurational parameters as required and press . To learn more about dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

To create a dashboard from template:
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1.  

2.  

3.  

4.  

If you need to change dashboard's name , ID or any other configurational setting, you can edit a dashboard.

Note: Only custom dashboards can be edited, predefined dashboards are read-only, but you can use them as 
templates and create a custom dashboard whose parameters will be editable. To learn how to create dashboards 
from templates, see .Creating Dashboards

Press  button  in the dashboards panel toolbar.Settings

In the opened dialog box click  button.Manage...

In the  window select any of the custom dashboards from the list and click .Manage dashboards Edit...

Adjust all configurational parameters as required and press . To learn more about dashboard's OK
configuration parameters, see .Adjusting Dashboard Configuration

Editing Dashboards

To edit dashboard's configuration:
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1.  

2.  

3.  

Note: Predefined dashboards cannot be deleted, but any of the custom dashboards can be deleted.

If you want to delete a dashboard, follow the steps described below.

Press  button  in the dashboards panel toolbar.Settings

In the opened dialog box click  dashboards.Manage...

In the  window select any of the custom dashboards from the list and click .Manage dashboards Delete

Deleting Dashboards

To delete a dashboard:
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1.  

2.  

3.  

1.  

The  allows creating new projects as well as renaming and deleting projects that are not active. Projects view
NOTE: You cannot rename or delete a project that is set as active.

To create a project, in the Projects view, in the toolbar, click  ( ). The Project Create Wizard opens.Create Project

In the Project screen, in the  field, specify the name of the project.Project name

To keep the default location to store the project, leave the  checkbox selected. If you want Use default location
to change the location, clear the checkbox and enter the name of the new directory into the  field or Location
click  and select the directory in the folder tree.Browse

Click . The new project appears in the projects tree.Finish

To delete a project, in the Projects view, right-click its name in the tree and click  on the context menu. Two Delete
confirmation dialog boxes appear one after another:

Delete object dialog box is to confirm the deletion of the project itself. Click  if you are sure you want to Yes
delete it. Otherwise, click .No

Projects

Creating Project

Deleting Project
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2.  Delete project dialog box is to confirm the deletion of the project`s contents: these are the data stored in the 
file system, database connections are not affected. Click  if you want the contents to be deleted as well. Yes
To keep the contents, click .No

NOTE: If you have deleted a project and then re-create it with the same name, the new project picks up all the 
database connections of the deleted project.
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Note: This functionality is available only in .Enterprise-Edition

DBeaver support local storage for connection secure data. It includes:

Database server user credentials

SSH tunnel user credentials

Proxy user credentials

By default user names and passwords are stored in file . This file is encrypted using credentials-config.json

AES key. However it is really secure as this key is not secure (can be found in DBeaver sources) and thus this file 
can be un-encrypted by 3rd party people using some 3rd party software.

In DBeaver Enterprise there is much more strong security support.

It is possible to set master password for all projects in local workspace. Go to Preferences->Database->Security 
and enable option . There are several password storage providers (you can see Use secure passwords storage

them on page General->Security->Secure Storage),  is the default one (in DBeaver Enterprise Password Provider

standalone DBeaver). It will ask you to specify master password. DBeaver doesn't store this password anywhere, 
it only encrypts user credentials in special local storage. It is not possible to decrypt these password without 
password (at least easily).

Side effect of this configuration - you cannot share your connections (with password) between different users. 
Because user credentials are stored in a completely separate location and they are protected by local user 
password.

Project security

Master password for local configuration
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You can disable default password provider and enable "Windows Integration" provider. This provider doesn't need 
master password but it uses randomly generated password stored in local user secure storage (in Windows). This 
is easier (as you don't need to remember master password) but less secure (anybody who have access to your 
Windows user account will have access to DBeaver stored credentials).

You may specify a password for a project. It will encrypt all project's configurations with this password. Also you 
will be able to share your project settings with other users (you will need to pass the project password as well).

In order to enable project password open project properties. You can do this by:

Click on main menu File->Project security

Click on "Configure" icon in project explorer view toolbar and switch to Project Security tab

Press  on a project element in  view and switch to Project Security tabALT+Enter Projects

On project security page click on "Set Password" button to enable project password. Click on Clear to disable it 
(you will need to enter current project password to clear it).

Use Windows Integration password provider

Project password

"Encrypt configuration" option
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DBeaver is fully integrated with Git team work/version control system. You can keep your project configuration, 
scripts, diagrams, bookmarks and other artifacts in a Git repository.

Team work (Git)

Managing connection configuration

Managing secured resources

Managing scripts and other resources
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1.  

2.  

3.  

Bookmarks are quick access links to objects of a database. They appear in the project tree inside the  or Projects
 views.Project Explorer

To create a bookmark:

In the  or under  node of the Projects view, click the database object of Database Navigator Connections
interest to set focus on it.

Press . The  dialog box appears.CTRL+d Bookmark Name

In the  field, enter the bookmark name, then in the  field, click the folder, and Bookmark Name Bookmark folder
then click :OK

The bookmark appears in the selected folder of the related project.

To open an object using its bookmark, double-click the bookmark or right-click it and click  on the Open Bookmark
context menu. You can rename and delete bookmarks using the context menu as well.

Bookmarks
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Brief list of the most important DBeaver shortcuts.
Of course you can redefine any (or almost any) of these shortcuts, here is the list of the default values.
Most of the following commands are accessible from DBeaver main menu, context menu or editor toolbar (or from 
all of them).
Use context menu wherever it is possible - it usually shows all actions accessible at this moment.

Shortcut Action

CTRL+Enter Execute current query ( )*

CTRL+\ Execute current query in a new tab

ALT+X Execute current script ( )**

CTRL+ALT+' Execute selected SQL expression and print results

CTRL+SHIFT+E Explain current query execution plan

CTRL+ALT+SHIFT+X Execute queries of current script simultaneously, showing results in separate tabs

CTRL+9 Switch active connection (for SQL script)

CTRL+Space  Option+SpaceSQL completion proposals popup

CTRL+ALT+Space SQL templates proposals popup

CTRL+SHIFT+F Format current script ( ) using current formatter**

CTRL+/  CTRL+SHIFT+/Toggle single/multi line comment

ALT+Up  ALT+Down Jump to previous/next query

CTRL+6  CTRL+SHIFT+6
ALT+6

Toggle editor/results panels (maximize/minimize/switch)

CTRL+SHIFT+X  CTRL+SHIFT+YConvert selected text into upper/lower case

Shortcut Action

TAB Switch to record/grid mode

CTRL+~ Switch presentation (grid, plain text, json ,etc)

CTRL+1 Foreign keys navigation menu

ALT+Space Navigate to the link in active cell

ALT+Left Navigate backward in history

ALT+Right Navigate forward in history

CTRL+2 Toggle sorting by current column

Shortcuts

SQL Editor

Data viewer
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F11 Current column filters menu

CTRL+F11 Current column filter dictionary panel

F7  CTRL+7 Toggle right panels on/off

F5 Refresh results (re-run query)

Shortcut Action

Enter Activate inline editor

SHIFT+Enter Open value editor dialog or separate value editor (for LOB values)

Delete  ALT+Delete Delete row

ALT+Insert Add new row

CTRL+ALT+Insert Copy current row

Escape Cancel changes in current cell/row

Shortcut Action

F2 Rename current element (if supported)

F4 Open editor of selected element(s)

F5 Refresh selected element(s)

Delete Delete selected element(s) (if supported)

CTRL+ALT+SHIFT+D Add bookmark on selected element

Alt+Enter Show properties of selected element

F3  CTRL+[ Open SQL editor for current connection ( ). Shows script selector popup.***

CTRL+F3  CTRL+] Open new SQL editor for current connection ( ). Always creates new script.***

CTRL+Enter
Open recent SQL editor for current connection ( ). Opens last modified script or creates a new ***
script.

Shortcut Action

ALT+~ Shows database tools context menu

CTRL+0 Switch active schema/catalog (available if SQL/database editor is open)

CTRL+SHIFT+C
Advanced copy. Works in different contexts and performs "smart copy" operation (usually with 
parameters).

CTRL+SHIFT+V Advanced paste. Same as "smart copy" but for "paste".

Data editor

Database Navigator

Other
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*  - Current query is the query under cursor or the selected text. Query is separated from other script queries by 
delimiter (; by default) or by empty lines.

 - Current script is a set of all queries in the current SQL file. If there is a text selection then only queries in this **

selection are processed. Queries are separated from each other with a delimiter (; by default).
 - Current connection detected from active window and selection. If active (focused) window is SQL editor or **

database object editor then current connection is the same as in this editor. If active window is database navigator 
then active connection is "owner" connection of currently selected element. In other cases there is no current 
connection and DBeaver will ask you to choose connection explicitly.

References
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To be able to manage your database in DBeaver, you need to create a connection to this database – see Creating 
. A connection includes a driver and a number of configuration parameters including the location of Connections

the database and credentials to access it. You need to create a separate connection to every database you want 
to manage. Every database type requires its own set of connection parameters.

Connections reside in the  and in the  views. In these views, you can:Database Navigator Projects

Edit connections, see Editing Connections

Rename and delete connections - via corresponding context menu items, see Database Navigator

Connect to and disconnect from databases using connections, see  and Connect to Database Disconnect 
.from Database

Database connections might have the following states:

 - not connected

 - has network settings specified (such as SSH tunnel, etc.) 

 - connected

 - connection error

Database Connections
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DBeaver provides a wizard that guides you through the steps to create a connection. If you run DBeaver for the 
first time (standalone version), the new connection wizard appears automatically. In other cases, to create a 
connection, do one of the following:

Click the  button in the application toolbar or in the Database Navigator view toolbar:New Connection Wizard

Click  in the menu bar:Database -> New Connection

Press  or click  in the menu bar:Ctrl+N File -> New

Create Connection
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Then, in the wizard, click  and then click :Database connection Next

Then, in the  wizard:Create new connection
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1.  Choose a driver for the new connection: click the name of the suitable database type in the gallery. Then click 
.Next

To quickly find the needed driver, you can type a hint in the text field above the list of drivers.
If you cannot find a driver for your database then probably there is no suitable driver and you need to create 
one. Please see  article.Database Drivers

NOTE: The list of database drivers diaplays the number of exising connections next to each driver. No 
number is displayed if there are no connections.

If you prefer the classic list view of the available drivers, use the  button.Classic
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2.  

You can choose Simple mode on this step. Simple mode gives simplified access to the database. Basically with 
the ability to view data only in schemas and tables.

In the Connection Settings screen, on the General tab, set all primary connection settings:
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3.  

4.  

5.  

For most drivers required settings include:

Host

Port

Database name

User name and password

However, the number and type of connection properties are very dependent on the driver.
For example, embedded drivers (such as SQLite, Derby Embedded, HSQLDB, H2 Embedded), unlike remote 
ones, require only the path to the database.

If necessary, specify advanced settings, see  section below, and click .Advanced Settings Next

To test if the connection works, click .Test Connection

Click . The connection appears in the tree of connections in the Database Navigator and DBeaver Finish
actually connects to the database.

Advanced Settings
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If your database cannot be accessed directly, you can use SSH tunnel:

DBeaver supports following SSH authentication methods: user/password, public key authentication and agent 
authentication. Supported implementations for agent authentications are  and .pageant ssh-agent

If a connection has network settings specified, such a connection appears in the application with a special 'arrow' 
icon such as this: 

You can also set the connection name, type and initial settings (such as bootstrap queries, transaction state, 
global filters, etc.).

Network Settings (SSH, SOCKS, SSL)

Connection Details (name, type, etc.)

https://www.digitalocean.com/community/tutorials/how-to-use-pageant-to-streamline-ssh-key-authentication-with-putty
https://help.github.com/en/github/authenticating-to-github/generating-a-new-ssh-key-and-adding-it-to-the-ssh-agent
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Each driver has its own set of additional properties. Refer to the driver documentation to get information about 
available properties and their values.

Driver Properties
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You can use variables in all connection parameters and in the driver properties. Variables are system environment 
variables or one of the following list:

Name Value

${host} Host name

${port} Port number

${database} Database name

${server} Server name

${url} Connection URL

${user} User name

Variables in parameters
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${password} User password

Note: option  must be turned on (see preferences).Use environment variables in connection parameters
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To edit configuration settings of a database connection, in the  or in the  view, right-Database Navigator Projects
click the connection and click  on the context menu. The Connection configuration window opens:Edit Connection

The navigation pane on the left displays configuration sections, most of which are the same as those in the Create 
new connection wizard, see . There are additional configuration sections as well, such as Connect to Database

 and . Click the section name to open the configuration settings for editing.Result Sets SQL Editor

You can test if your connection works with modified settings - click . When you finish editing your Test Connection
connection, click  to save the changes or  to discard them.OK Cancel

In development

JDBC Time Zones

Edit Connection

Driver settings
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To be able to work with the content and structure of a database, you need to connect to it. When you create a new 
connection to a database, DBeaver automatically connects to the new database, see .Create Connection

To connect to a database using an existing connection, in the  or  view, click the Database Navigator Projects
connection and then click the Connect button in the toolbar or click  on the main menu:Database -> Connect

You can also right-click the connection and click  on the context menu.Connect

If a database connection exists but DBeaver is not connected to the database, the connection appears with its 

original icon (for example,  for PostgreSQL database). When DBeaver connects to the database, the icon 

changes to signal the connected status: .

If DBeaver cannot connect to a database, the connection appears with an error sign: . If you attempt to connect 
to such a database, DBeaver displays an error message describing the cause for the error.

Connect to Database
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You might need to invalidate a database connection and then to reconnect to it again in such cases as connection 
to the server being lost, etc. To invalidate a database connection and then reconnect to the database, in the 
Database Navigator or Projects view, click the database connection and then click the  button Invalidate/Reconnect
in the toolbar or  on the main menu:Database -> Invalidate/Reconnect

You can also right-click the connection and click  on the context menu.Invalidate/Reconnect

Invalidate/Reconnect to Database
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You might need to disconnect from a database to free up resources or close transactions. To disconnect from a 
database, in the  or  view, click the connection and then click the Disconnect button in Database Navigator Projects
the toolbar or click  on the main menu:Database -> Disconnect

You can also right-click the connection and click  on the context menu.Disconnect

NOTE: The Disconnect button and menu items are available only for those connections that are activated, that is, 

marked with the connected sign: .

When DBeaver disconnects from a database, its icon changes to its original state (not connected), for example, 
for PostgreSQL database.

To disconnect from all active connections, click  on the main menu.Database -> Disconnect All

Disconnect from Database



DBeaver User Guide 21.0. Page 190 of 334.

Connection types define how DBeaver behaves regarding:

Default transactions commit mode - with or without automatic commit of changes to the database.

NOTE: You can override the default commit behavior during your work with connections by changing the 
commit mode, see .Auto and Manual Commit Modes

SQL statements execution (with or without user confirmation). If set to require user confirmation for SQL 
execution, DBeaver shows a confirmation message every time you attempt to execute a ‘transaction’ type of 
query (INSERT/DELETE/UPDATE, etc.):

For your convenience, DBeaver supports color-coding of connection types so that you know at once which 
behavior to expect when you use a certain connection. Colored are database connections that use a certain 
connection type in the  and  views as well as editors related to these connections:Database Navigator Projects

Connection Types
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1.  

2.  

To manage connection types for a database connection, in the Database Navigator or Projects view, click the 
connection to set focus to it and then press  to open the connection properties window. Then, in the properties F4
window, in the navigation pane on the left, click  to see the general settings. You can see  General Connection Type
field among the settings:

There are three default connection types – , , and . You can change the connection Development Test Production
type for your database connection as well as you can create a new connection type, edit or delete an existing one.

By default, the  connection is preset for all database connections. You can change the connection Development
type to one of the default connection types or to a custom type, if there are any.

To change the connection type:

In the connection properties window, on the  page, click the  field and then click the General Connection type
connection type in the dropdown list:

To test the connection, click . To confirm the change, click .Test Connection OK

Change Connection Type
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1.  

2.  

3.  

To create a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field. The Properties for connection types window opens:Connection type

The window displays existing connection types and their settings.

Click the new connection type button. A new connection type appears in the list: 

Now you can specify the settings for the new connection type:
Enter the connection type`s name into the  field.Name

Enter a description into the  field, if needed.Description

Click the  box and select the color for the new connection type.Color

To set DBeaver to automatically commit changes to the database when connections use this connection 
type, select the  checkbox. Otherwise, leave it empty.Auto-commit by default

To set DBeaver to ask for your confirmation at each execution of SQL statement of ‘transaction’ type, 
select the  checkbox. Otherwise, leave it empty.Confirm SQL execution

Create Connection Type
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4.  

1.  

2.  

3.  

1.  

2.  

3.  

4.  

Click  to apply the changes and keep the window open or click  to apply the changes Apply Apply and Close
and close the window. To discard all changes and return to the previous state, click .Restore Defaults

To edit a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field.Connection type

Specify the settings for the new connection type the same way as when you create a connection type, see 
'Create Connection Types' section above.

When you finish editing the connection types, click  to apply the changes and keep the window open or Apply
click  to apply the changes and close the window. To discard all changes and return to the Apply and Close
previous state, click .Restore Defaults

To delete a connection type:

In the connection properties window (  on a connection), on the  page, click  next to the F4 General Edit
 field. The Properties for connection types window opens.Connection type

In the Properties window, in the list of connection types, click the connection type to set focus to it and then 

click the delete button under the list: 

Click  in the confirmation dialog box to confirm the deletion. Otherwise, click .Yes No

Click  to apply the changes and keep the window open or click  to apply the changes Apply Apply and Close
and close the window.

Edit Connection Type

Delete Connection Type



DBeaver User Guide 21.0. Page 194 of 334.

DBeaver supports two modes for committing changes to the database:

Auto-commit transfers all changes that you make immediately to the database.

Manual commit requires your confirmation before committing a change to the database or rolling it back.

Though available in many cases, the two modes are actionable only in . See the next sections for SQL Editor
details of using the modes.

To switch between the modes, use the mode selection button that appears in one of the two views:  or .

Auto-commit mode is the default one for the Development and Test connection types, see . Connection Types

Auto-commit mode is on if you can see the auto-commit view of the mode selection button ( ) in the application 

toolbar. If you see the manual commit view ( ), then in order to switch to auto-commit mode, click the mode 
selection button – it changes to auto-commit. At the same time, this disables the two manual commit buttons in the 
toolbar:  and  – these are available only in manual commit mode.Commit Rollback

The statistics field next to the mode selection button always shows  in auto-commit mode: .Auto

Clicking the statistics field opens the .Transaction Log

Manual commit is intended to protect your database from inadvertent changes and that is why it is the default 
mode for Production connection type, see .Connection Types

Manual commit mode is on if you can see the Manual commit view of the mode selection button ( ) in the 

application toolbar. If you see the auto-commit view ( ), then in order to switch to manual commit mode, click the 
auto-commit button – it changes to manual commit. At the same time, this enables the two manual commit buttons 

in the toolbar:  ( ) and  ( ).Commit Rollback

In manual commit mode, when you execute SQL statements ( ), the number of database modifying Ctrl+Enter
statements that pend commitment to the database appears in the statistics field next to the mode selection button: 

.

If you hover you mouse over the field, you can see statistics of your SQL statements:

To commit statements to the database, click the  button in the toolbar. To discard them, click .Commit Rollback

Auto and Manual Commit Modes

Auto-Commit Mode

Manual Commit Mode
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If no modifying statements have been made, the statistics field shows : None

Clicking the statistics field opens the .Transaction Log

When smart commit is enabled and you are in auto-commit mode then DBeaver will monitor your activity.
Once you will try to execute any data modifying query (UPDATE, INSERT, DELETE, UPSERT, MERGE, etc) 
DBeaver will switch to manual commit mode before executing your query. Also if you will edit table data and save 
your changes - DBeaver will also switch to manual mode before actual data modification.

If option "Return to auto-commit on transaction end" is on then DBeaver will switch back to auto-commit mode 
once you execute Commit or Rollback command (using main toolbar or main menu actions).

Smart commit mode is very useful if most of the time you are working in read-only mode. It doesn't lock tables 
when you perform SELECT queries. Transaction will be started only when you start to modify your data.

For both, Auto and Manual commit modes, you can select the transaction isolation level. To do so, click the arrow 
next to the mode icon and then click the required option in the dropdown list:

Smart Commit Mode

Transaction Isolation Level
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Transaction Log shows all transactions (queries of ‘transaction’ type such as INSERT/DELETE/UPDATE and 
others) made during the current DBeaver session. To open the Transaction Log, click the  button (Transaction log

) in the toolbar or the statistics field to the left of it.

The Transaction Log window shows transactions that are:

In progress or pending - shown without any special color

Successfully committed – in green: 

Rolled back – in orange or red: 

To see all previous transactions during the current session, select the  checkbox. To Show previous transactions
see all queries including non-transactional ones, select the  checkbox.Show all queries

Transaction Log
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It might be useful to check pending transactions because they might lock your database. To see pending 
transactions, click the arrow next to the  button in the toolbar and then click  Transaction Log Pending Transactions
on the dropdown menu:

The upper table of the Pending transactions window shows currently active connections and the number of their 
transactions. The bottom table shows query details of the connection that is currently in focus in the upper table:

When the Pending transactions window opens, the upper table shows only those connections that have pending 
transactions. If no connections have pending transactions, the table is empty. To see all connections that are 
currently active (connected), select the  checkbox.Show all connections

You can commit or roll back transactions right from the Pending transactions window: in the upper table, click the 
row with required uncommitted transactions and then click the  or  button, depending on your Commit Rollback
purpose. If a transaction is committed/rolled back successfully, both buttons are disabled. If the operation is 
unsuccessful, the system displays an error message.

To see all previous transactions made during the current session, select the  Show previous transactions
checkbox. To see all queries including non-transactional ones, select the  checkbox. The green Show all queries
rows are committed transactions, orange (or red) ones are rolled back, rows without a special color are non-
transactional or pending transactions.

Pending transactions
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You can use pre-configured database driver or create new driver.

DBeaver has a lot of pre-configured driver including SQL, NoSQL, key-value databases, graph databases, search 
engines, etc. But sometimes you need to connect to a database which was not configured in DBeaver yet.

All you need is JDBC driver of your database. The rest is easy.

JDBC driver is a program (in Java) which can connect and operate with some local or remote database server. It 
usually provides all needed functionality to cover 100% of database functionality. Usually, JDBC driver are 
provided by database vendors to let customers ability to work with their databases.

JDBC driver consists of one or multiple  files. Jar file is a library which contains program code and some other jar

files. You need to download driver's jar files before adding them in DBeaver. Sometimes jar files are included in 
database server distribution - in that case you need to refer your database documentation or ask your DBA.

Database drivers

Obtaining JDBC driver

Adding driver configuration in DBeaver

Open driver manager dialog
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You can open driver manager from main menu:

or from Database Navigator drop-down menu.

Add new driver
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Just click the button New and create a new driver. On the driver edit dialog you need to enter all required 
information:

Parameter Description

Driver Name Name of your driver. It can be any name you like

Driver Type Driver provider. In 99% cases you will need Generic driver (JDBC provider)

Class Name
JDBC driver class name. You can get it from the documentation or find it in jar files (see "Find Class" button 
description)

URL 
Template

Template of driver URL. You can leave it empty. But in this case you will be ready to set JDBC URL for each 
your connection. It is better to define a valid template, this will greatly simplify connections creation. See 
"URL Templates" for the detailed description

Default Port Default database port. You can get it from documentation or leave it empty

Embedded
Enable it for server-less databases. This flag affects a few config options related to network/connections 
management

Main parameters
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No 
Authentication

This means that driver doesn't require authentication (no user/password fields will be shown)

Category Driver category, deprecated

ID Driver unique ID, ignore it

Description Driver description, it is shown on some dialogs/wizards as a hint

This is the list of jar files, binary libraries (dll or so) and any other files required by driver. In most cases you need 
only jar files.
Click "Add File" to add single jar file, "Add Folder" to add folder with Java classes/resources and "Add Artifact" to 
add Maven artifact (see below).

After you add jar files you will be able to find all JDBC driver classes which present in these jars. Just click on the 
"Find Class" button and DBeaver will show all of them. In most cases there is just one driver class in the driver. If 
there are many of them then you need to refer to the driver's documentation.

DBeaver can download driver jars directly from Maven repository (it is a global public repository of Java libraries, 
usually open-source). If your database driver is published on some public repository you can use this feature. 
Maven artifacts are better than plain jar files because you can see all existing driver versions and can change 
driver version in runtime without any driver properties reconfiguration.

After you finished configuring your driver just press Ok button.
Now you can .create connection

If you need to change some driver properties later you can access them directly from connection properties dialog:

Libraries

Maven artifacts

Saving driver, adding connection
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JDBC drivers use URLs to identify remote servers - strings similar to classic web URLs. Usually, URL has form 
, for example `jdbc:postgresql:localhost:5432/postgres'. It is not very convenient jdbc:vendor:host:port/database

to edit such long and unobvious string. DBeaver can construct this URL from connection parameters (like host, 
port, etc).

For example above the URL template is: jdbc:postgresql://{host}:{port}/{database}
Host, port and database are parameters which you will need to enter on the connection configuration page.

Supported URL variables:

Parameter Description

{host} Database server host name

{port} Database server port number

{database} Target database name

{server} Target server name (rarely used)

{folder} Folder path (on the local file system). Used for embedded drivers

{file} File path (on the local file system). Used for embedded drivers

URL Templates

Advanced settings
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For most driver you don't need to change any advanced properties. But in some cases you can use this as a driver 
tuning, e.g. for better performance or for structure fixing.

Parameter Description

Driver supports indexes Driver supports table indexes

Driver supports stored code
Whether this driver supports stored code (procedures, functions, packages, 
etc)

Driver supports references Driver supports table references (foreign keys)

Driver supports SELECT count() clause | 
) clauseDriver supports SELECT count(

Driver supports views Driver supports table views

Split procedures and functions Show procedures and functions in different folders

Script delimiter Literal for SQL queries separation in scripts

Main parameters
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Script delimiter redefiner SQL clause which redefines script delimiter value

Use script delimiter after query Keep SQL script delimiter after each SQL query

Use script delimiter after SQL block Keep SQL script delimiter after SQL script blocks (BEGIN/END)

String escape character Character used to escape special symbols in strings

Meta model type Type of metadata reading model - standard or indexed

All Objects Pattern SQL pattern for all metadata objects

Omit catalog(s) Do not read and use catalog (aka database) information

Omit single catalog Hide catalog (database) if there is only one catalog on server

Omit schema(s) Do not read and use schemas information

Omit single schema Hide schema if there is only one schema on server

Use schema filters
Use JDBC schema filters when database doesn't support catalogs. 
Otherwise just read all database schemas and filter on client-side

Omit type cache Do not use data types provided by driver

Shutdown parameter Database shutdown URL parameter

Create database parameter Database create URL parameter

Driver supports multiple results Driver supports multiple results for a single query

Driver supports result set limit Driver supports multiple result set limit (max rows)

Driver supports structure cache Driver supports structure cache reading. Enables schema columns, keys, etc

Driver supports TRUNCATE operation
Driver supports TRUNCATE command. It is much faster than DELETE 
without criteria

Parameter Description

Get active database Query to obtain active database name

Set active database Query to change active database

Shutdown database Query to shutdown active database connection. Used for some embedded databases

PING query Query to check connection state

Dual table name Name of dummy 'DUAL' table which is used for expressions evaluation

Active object type Type of selectable object (schema, catalog)

Driver supports results scrolling Driver supports resultset scrolling

Quote reserved words Quote columns/table names if they conflicts with reserved SQL keywords

Escape LIKE masks in search 
queries

Use to access JDBC metadata API. Enabled by default but should be disabled for some 
(broken) driverss

Queries (Custom driver queries)

DDL (DDL generation options)



DBeaver User Guide 21.0. Page 205 of 334.

Parameter Description

Drop column short syntax Use 'ALTER TABLE DROP column-name' instead of standard syntax

Drop column - use brackets Use 'ALTER TABLE DROP (column-name)' instead of standard syntax

Use legacy SQL dialect for DDL Use legacy SQL dialect for DDL

Add COLUMN keyword in alter table 
query

Add COLUMN keyword after keyword ADD and before column name in alter table 
query

Parameter Description

Timestamp 
format

Format pattern for timestamp columns

Date format Format pattern for date columns

Time format Format pattern for time columns

If you have configured some driver, it works good and you think that it makes sense to have this driver 
configuration in standard DBeaver, please send your configuration to us. Just create a feature request issue on 
GitHub and copy/paste driver description to the ticket (in any suitable form).

Thank you :)

Formatting (SQL values formats)

Summary
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1.  

You can perform data export/import or migration for database table(s). We'll describe most typical use cases.

Select a table(s) you want to export. In the context menu choose "Export Data".
(Note: you also can export data from custom SQL queries results. For that in results context menu choose 

"Export results"). 

Data export/import

Exporting table data to CSV format
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2.  

3.  

Choose export format. DBeaver support many different output formats including CSV, HTML, XLSX, etc: 

Set data extraction options (how data will be read from tables). This may affect extraction performance. And 
set export format option. They are specific to the data format you chose on step 2: 
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4.  Set options for output files or clipboard. Note: Timestamp pattern here is used for target file name pattern: 
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5.  

6.  

Review what and to what format you will export. You can also save all your settings as a task in this step or 
change task variables: 

Press finish. See extraction progress. Actual data extraction will be performed in background, you can keep 
working with your database during export process. Note: avoid changing data in tables you selected for 

export while export is running. In the end you will see status message: 

You can import data from CSV file(s) directly into your database table(s).

Importing data from CSV format
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1.  

2.  

Select a table(s) to which you want to import data. In the context menu choose "Import Data": 

Choose import format (CSV):
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3.  Select input CSV file for each table you want to import and you can change Importer settings (format specific) 
on this step: 
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4.  Set CSV-to-table mappings. You need to set some column in CSV file for each database table column. You 
can skip some column at all (in target table column value will be set to NULL). You can set some constant 
value for table column if there is no source column for it in CSV. 
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5.  Set options for loading data in database. These options may affect performance: 

About replace method option you can .read here
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6.  

7.  

Review what file(s) and to what table(s) you will import. You can also save all your settings as a task in this 

step: 

Press finish. See extraction progress. Actual data loading will be performed in background, you can keep 
working with your database during export process. Note: avoid changing data in tables you selected for 

import while import is running. In the end you will see status message: 

Related topic: Migrating table(s) data to another database table(s)
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DBeaver supports data migration from tables of one database to tables of another one.

To perform data transfer, please, follow the steps below.

In the  select one or more tables you want to export. In the context menu choose "Export Database Navigator
Data". (Note: you also can export data from the custom SQL queries results. For that in the results context menu 
choose "Export results").

In the opened dialog box choose  type as the data transfer target and press .Database Next

Data migration

Step 1: Define the data source

Step 2: Define data transfer target type
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For proper table mapping the following options are available:

Step 3: Define data mapping
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Target container - defines a database or a scheme where the data will be transferred to. Press  button 
and choose the container.
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Source - contains names of all the tables selected at step 1. You can also see the list of columns existing in 

the source table by pressing 

Target - contains names of the tables where the data will be transferred to.

Mapping - contains the list of actions to be applied to the source data on data transfer. The following options 
are available:

- the source data will be populated into a newly created table or column of the target container.Create
 - the source data will not be transferred to the target container.Skip

 - the source data will be transferred to the table that already exists in the target container.Existing
 - this value is set by default when there is no target defined.Unassigned

If cells are marked as  it means that in the target table there are no source tables with matching names, 
otherwise the names will be filled in automatically.

You can define a target table by clicking on a cell in the  column and entering its name, or press the  Target New

button  and enter a new name in the opened dialog box.

You can also choose a name for a target table from the drop-down list.
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Or select from the list of tables already existing in the target container by pressing the  button Browse

To define mapping setting for a column in a target table, release the list of source table columns by pressing  
next to the table's name in the  column, then click the name of the target column and enter a new one or Source

select one from the dropdown list. To collaps the list, press 

If you want tables of the target container to be named like those of source, press the  button Auto assign

 and the  column will be automatically populated.Target
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You can also define the names of target columns, as well as their data types, by clicking a row with a table name 

and pressing the  button Columns

The following elements are available here:

Source column -this column contains names of columns existing in the selected source table;

Source type - this column contains the list of data types assigned to the columns in the selected source table;

Target column - this column contains names of target table columns where the data from source column will 
be transferred to. To change the name, click the cell and enter a new name.

Target type - this column contains the list of data types that will be assigned to the columns in the target 
table.

: Sometimes data types that are supported on the source database are not supported on the IMPORTANT
target or vice versa. 
To set a data type for a column in a target table, click the cell in the  column and select one from Target Type
the dropdown list of data types supported on the target.

Mapping - this column contains the list of actions to be applied to the data on data transfer.

To change mapping type click a cell in  column of  and select the required Mapping Table mapping dialog box
mapping type.
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You can also view the SQL script that will be run on data transfer by pressing the  button Target DDL

.

If you want to see in advance the preview of the imported data, you can select the  buttonPreview data



DBeaver User Guide 21.0. Page 222 of 334.

The following keyboard shortcuts for easy navigation within the mapping table area of  screen are Table mapping
supported:

Shortcut Action

Up Moves one row up.

Down Moves one row down.

Right Releases the list of source table columns.

Left Swaps the list of source table columns.

Space Auto-assigns the target.

Del Sets mapping type to skip.

Configure data mapping and press .Next

Data export settings are grouped into  and .Extraction settings Data load settings

Step 4: Define export settings
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Extraction settings define how the data will be pulled from the source. The following options are available:

Option Description

Maximum 
threads

Defines a number of threads to be used for data transfer.

Extract type
Select  option if your data load is not too big. Select  option if you need to migrate a Single query By segments
solid amount of data. When this options is selected you can set the  value, that is to define a Segment size
number of rows to be transferred in each segment.

Open new 
connections

If selected, a new connection will be opened and data transfer will not interfere with other calls to the database 
whose data is being transferred.

Select row 
count

If selected, a progress bar displaying data migration process will be shown.

Extraction Settings

Data load settings
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Data load settings define how the extracted data will be pushed to the target. The following options are available.

Option Description

Truncate data 
load table before 
load

Select this check-box only if you want all the data be cleared from the target table. Be very careful with 
this option!

Replace method
Select this drop-down list if you want change import behavior in case of duplicate primary key value. 
Data Import and Replace page

Open new 
connections

Use this option to speed up data transfer. If selected, a new connection will be opened and data transfer 
will not interfere with other calls to the database where data is being transferred to.

Use transactions
This option allows to speed up data transfer and to define the number of rows for each transaction by 
setting  parameter.Commit after insert of

Disable batches
Select this check-box if you want disable the use of batch imports. Import will be made row by row.
Enabling this function will show all import errors, but make the import process slower.

Open table editor 
on finish

If selected, the table editor to be opened when data transfer is over.

Show finish 
message

If selected, a notification message will be shown when transfer is over.

Check out data transfer settings and press  or save as .Start task

Step 5: Confirm
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Sometimes there are situations when you want to ignore the current primary key value when importing into a table. 
Some databases have syntax constructs in addition to the INSERT INTO that may help.

The choice of the replacement method is in the import settings - in "Data load settings".

By default, the selection is >, you can select other options from the drop-down list. The options available <None

depend on the target database you are importing to.

Data Import and Replace

Data Import and Replace.
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The database can only support the replace method or only the ignore method. In this case, the list of methods will 
consist of only one item except >. If the base does not support replacement methods or we have not added <None

an implementation yet, then the combo with the list will be disabled.

Further you will find a list of databases supporting these methods and examples of syntax.

Let's take a look at an example of how this works. We use a simple small slightly modified Sakila (MySQL) table - 
sakila.language

CREATE TABLE language_insert (
language_id tinyint unsigned NOT NULL,
name char(20) NOT NULL,
last_update timestamp NOT NULL,
PRIMARY KEY (language_id)
);

INSERT INTO sakila.language_insert (language_id,name,last_update) VALUES
(1,'English','2006-02-15 05:02:19.0'),
(2,'Italian','2006-02-15 05:02:19.0'),
(3,'Japanese','2006-02-15 05:02:19.0');

If we try to execute this request twice, then the second time we get the following error: SQL Error [1062] [23000]: 
Duplicate entry '1' for key 'language_insert.PRIMARY' (This message may look different in other databases).

Let's take a new .csv file with the following content and try to use replace methods

"language_id","name","last_update"
1,Spanish,"2020-04-20 05:02:19.0"
2,Russian,"2020-05-20 05:02:19.0"
3,Belgian,"2020-06-20 05:02:19.0"
4,Mandarin,"2006-02-15 05:02:19.0"
5,French,"2006-02-15 05:02:19.0"
6,German,"2006-02-15 05:02:19.0"

If we set the "INSERT IGNORE" method in the settings, the result of the insert will look like this:

There will be no insertion errors, the first three lines will not change, and the fourth to sixth lines will be added to 
the table.

If we set the "REPLACE INTO" method in the settings, the result of the insert will look like this:
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There will be no insertion errors, the first three lines will be replaced and the fourth to sixth lines will be added to 
the table.

INSERT IGNORE and REPLACE INTO

Insert examples:

"INSERT IGNORE"

INSERT IGNORE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

"REPLACE INTO"

REPLACE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Documentation 
"INSERT OR IGNORE" and "INSERT OR REPLACE"

Insert examples:

"INSERT OR IGNORE"

INSERT OR IGNORE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

"INSERT OR REPLACE"

INSERT OR REPLACE INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Which databases support replace/insert methods?

MySQL

SQLite

https://dev.mysql.com/doc/refman/8.0/en/insert.html
https://dev.mysql.com/doc/refman/8.0/en/replace.html
https://sqlite.org/lang_insert.html
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Available for . PostgreSQL version 9.5
"ON CONFLICT DO NOTHING" and "ON CONFLICT DO UPDATE SET"

Insert examples:

"ON CONFLICT DO NOTHING"

INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0') ON CONFLICT DO NOTHING;

"ON CONFLICT DO UPDATE SET"

INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0')
ON CONFLICT (language_id)
DO UPDATE SET (language_id, name, last_update) = (EXCLUDED.language_id, EXCLUDED.name, EXCLUDED.last_update);

Available for . FireBird version 2.1
"UPDATE OR INSERT INTO"

Insert examples:

"UPDATE OR INSERT INTO"

UPDATE OR INSERT INTO language_insert(language_id, name, last_update)
VALUES(1, 'English', '2006-02-15 05:02:19.0');

Available for . Oracle version 11.2
"INSERT IGNORE ROW INDEX"

Insert examples:

"INSERT IGNORE ROW INDEX"

INSERT /*+ IGNORE_ROW_ON_DUPKEY_INDEX(LANGUAGE_INSERT, LANGUAGE_INSERT_PK) */
INTO LANGUAGE_INSERT(LANGUAGE_ID, NAME, LAST_UPDATE) VALUES(1, 'English', TIMESTAMP '2006-02-15 05:02:19.0');

PostgreSQL

FireBird

Oracle

https://www.postgresql.org/docs/9.5/sql-insert.html
https://firebirdsql.org/refdocs/langrefupd21-update-or-insert.html
https://docs.oracle.com/cd/E11882_01/server.112/e41084/sql_elements006.htm#CHDEGDDG
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DBeaver supports native database backup/restore functions for following databases:

PostgreSQL

MySQL

Native backup restore differs from standard DBeaver  feature. It uses database native dump formats data transfer
and it may work much faster as it uses special utilities for direct high-performance database access.

These functions can be accessed from context menu Tools or main menu Database->Tools. 

In order to execute native backup/restore tools you need to configure database native client. Native client is a set 
of binaries (different for different OSes) which will be executed by DBeaver to process actual backup/restore. 
Native client configuration can be done in  or directly from backup/restore wizard. Just click on driver editor dialog

 button in the button bar: Client ...

To configure new client location choose  item and ad new client in the following dialog:Browse ...

Database backup/restore

Database Backup/restore

Native client configuration
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You can choose what schemas/tables you want to backup/dump: 

Database dump object selector

Database native tool configuration
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You can pass a set of additional dump/restore parameters to the native tool. Particular set of configuration options 
depends on a database type.
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Task is a saved configuration of some database tool. It can be started from task management view or from menu 
by a single click. You can create tasks for frequently used tools. Also tasks can be  for regular execution.scheduled

You can save tool configuration into a task and run your task later with a single click. For example you can start 
 wizard and configure data export from several tables in MySQL database into CSV files:Data Transfer

Click on  button and fill task properties:Save configuration as task

Task management

Creating tasks

Create task from tool configuration
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Now click on  link to open task list:Open Tasks view

Editing/running tasks
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From task view you can add, edit, remove and execute saved tasks. You can use context menu or view tools for 

that: 

By clicking on  or by double-clicking on task you can open tasks edit wizard. In this wizard you can change Edit

task settings as well as actual tool configuration. You can change set of input objects for data transfer or any 
export configuration. After changing task settings click on  button (it is on the last Update configuration in task

page of task configuration wizard). 
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You can create task from scratch using tasks view. Open tasks view and  button in the view Create new task

toolbar or in the context menu. In task wizard you can choose task category, task type and name. On the next 
wizard pages actual tool configuration pages will be shown (they depend on chosen task type).

You can schedule tasks for later/regular execution. See  article.Task Scheduler

Create task from task management view

Scheduling tasks
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Note: This functionality is available only in .Enterprise Edition

DBeaver can schedule task execution for regular executions. DBeaver supports  on Windows Task Scheduler

Windows and  on macOS and GNU/Linux. On top of that as well, you can configure schedulers manually cron

.using command line

You can open the tasks view from the main toolbar:

or from the main menu Window. Select a task that you want to schedule in the tasks view and open the context 
menu:

The scheduler configuration dialog will be opened. You can configure task frequency, recurrence period, and start 
time there:

Task scheduler

Scheduling tasks from the Tasks view

Windows
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To schedule the task, click on the Schedule button. If everything is configured correctly you will see the 
confirmation dialog:
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1.  

If anything goes wrong you will see an error message dialog. Error details can be viewed in the  view.Error Log

You can change scheduler settings at any moment by choosing Edit scheduled task command from the context 
menu. You can also cancel the schedule by clicking on Remove schedule.

The first thing you need to open the tasks view. There are three ways to do that:

Database -> Tasks -> Database Tasks

macOS or GNU/Linux
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2.  

3.  

1.  

2.  

Window -> Database Tasks

Click on 'Show View (Database Tasks)' icon

Select a task that you want to schedule in the tasks view. To open the scheduler dialog, either:

Open context menu with right-click -> Scheduler -> Schedule task

or click on 'Schedule task' icon
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The scheduler dialog will be opened. It has a lot of similarities with the corresponding dialog on Windows, but 
unfortunately, there are a bit fewer settings on macOS and GNU/Linux due to the limitations of . For cron

instance, when configuring an hourly task, you can only choose the minute at which the task executes. In the 
example below, the task executes at 1:42 PM, 2:42 PM, 3:42 PM, and so on:

There is also no start date option, and, in case of minutely tasks, no start time either. The scheduler will execute 
the task at the specified recurrence, but there are no guarantees about when execution starts. It's also worth 
pointing out that even though you can specify seconds in the start time selector, they will be ignored. Most cron 
implementations do not support this type of granularity, and we are trying to be compliant with as many cron 
implementations as possible.

On macOS 10.15 or newer, when scheduling a task for the first time you will be prompted with something like this:
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Click 'Yes' to proceed. The reason for that prompt is that  settings (crontabs) are considered to be system cron

settings by macOS, and DBeaver won't be able to change them without permission.

After that, if everything is configured correctly you will see the confirmation message. Just like on Windows, you 
can change scheduler settings at any moment by choosing 'Edit scheduled task' command from the context menu, 
or cancel schedule by clicking on 'Remove schedule'.

You can see and change scheduled task details in the Windows Task Scheduler. Click on the Open scheduler 
settings command in the task view context menu:

All DBeaver tasks are located in a folder DBeaver.

You can take a look at the crontab DBeaver uses to schedule tasks in  by clicking the 'Open scheduler cron

settings' command in the task view context menu. You can also do it in the terminal by using the command 
. Although you can also edit the crontab by using , we strongly do not recommend it.crontab -l crontab -e

You can look through the task execution logs on the right side of the tasks view. By double-clicking on a task run 
item you can see the full log with all details, errors, and warnings:

See schedule details

Windows

macOS or GNU/Linux

Monitoring for task execution (any OS)
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1.  

2.  

DBeaver keeps the task run logs in the  directory, subfolder .metadata/task-stats.workspace

The task scheduler uses the DBeaver  interface to perform task execution. Command line parameter command line
 launches saved task execution (immediately). TASK_ID has form . -runTask TASK_ID @projectName:taskName

You can omit the project name part if you have only one project in your workspace. On Windows, you can use 
 executable to run tasks. Draw your attention that if you use  executable (by any reason) dbeaver-cli dbeaver

you will need to add command line parameter  to avoid splash screen appearance.-nosplash

If you encounter an error on Windows which looks like this: 
,ERROR: Invalid Start Date (Date should be in %some_format% format).

do the following:

Open file  in the directory with your DBeaver installationdbeaver.ini

Place the line  (where %some_format% is a format -Ddbeaver.scheduler.windows.dateFormat=%some_format%

from the error message) below the  line.-vmargs

This flag is available starting from the 7.3.4 EA version of DBeaverEnterprise and might be removed in the future.

Running tasks from the command line (any OS)

Troubleshooting

Windows Task Scheduler: incorrect date format
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Note: This functionality is available only in .Enterprise Edition

As the name suggests, the  is a type of task that consists of other tasks. Just like the other type of composite task
tasks, the composite tasks can be scheduled via . Let's take a look at what they can offer.Task Scheduler

The first thing we need to open  dialog. You can do it in multiple ways:Create a task

Composite tasks

Creating a composite task
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Choose , enter the task name, description (optional), and hit .Composite task Next

You will be presented with the following dialog:
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1.  

When creating a composite task you need to specify which tasks the composite task consists of.

This can be done:

By adding an existed task:

Setting up a composite task
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2.  By creating a new task and adding it simultaneously:
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3.  By drag-and-dropping a task from the :Database tasks panel
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As a side note, you can add a composite task to your new composite task.

You can edit tasks in the same dialog, delete a task from a composite task, change the execution order:

There is also a very important checkbox, . The tasks from the  are executed in the Ignore task error composite task
order they appear in the settings dialog. Executing a task from a  might produce an error that will composite task
block the next tasks from proceeding. The  checkbox can be used to bypass this behavior.Ignore task error
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DBeaver EE supports MongoDB schema browser, data viewer, SQL and JavaScript queries execution. Also it 
supports various administrative tools (like server sessions manager).
DBeaver uses MongoDB Java driver 3.8.0 to operate with server. It supports MongoDB servers from 2.x to 4.x.

You can connect directly to a server or use SSH tunneling or SOCKS proxy.
You can specify server address as host/port/database configuration or you can enter target database URL with all 
necessary parameters:

MongoDB

Overview

Connecting to MongoDB Server
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You can view/edit MongoDB collections content as standard relational tables (grid/plain text presentations) or as 
JSON documents.
Presentation can be switched in the Results Viewer toolbar.
In grid DBeaver will try to unify all documents in some particular collection (as they have the same structure/the 
same set of properties).

Browsing Mongo collections
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JS statements can be executed in SQL editor as usual.

Mongo scripting reference

Following example creates a user in the current database.

db.createUser({
    user: 'testuser',
    pwd: 'test',
    roles: []
})

This example returns all documents in collection 'test_col':

db.test_col.find().toArray()

Note: script will be executed in the current database.
You can not set explicit database name in your query.
Current database can be changed in SQL Editor toolbar or in Database Navigator.

Executing JavaScript
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You can use standard SQL statements ( , , , ) to manipulate Mongo data.SELECT INSERT UPDATE DELETE

SELECT * FROM test_col
WHERE propName.subProp='value'

UPDATE FROM test_col
SET propsName.val1=123
WHERE propName.subProp='value'

SELECT queries support , , ,  and  clauses.WHERE ORDER BY GROUP BY JOIN HAVING

Nested JSON fields can be divided by dot. If your field contains any special characters (e.g. spaces, dashes, etc) 
you must enclose it with double quotes. For example:

SELECT title FROM movies WHERE info.'imdb-details'.rating > 6

If you need to operate with dates then you must specify them in ISO format. It is possible in both JavaScript and 
SQL dialect:

db.dates.insert([
    { value: new Date('2016-05-18T16:00:00Z') },
    { value: new Date('2017-05-18T16:00:00Z') },
    { value: new Date('2018-05-18T16:00:00Z') },
    { value: new Date('2019-05-18T16:00:00Z') },
    { value: new Date('2020-05-18T16:00:00Z') }
])

Querying data in JavaScript:

db.dates.find({
    value: { $gte: new Date('2018-05-18T16:00:00Z') }
}).toArray()

Querying data in SQL dialect (ISO and UNIX timestamp, in milliseconds):

SELECT value FROM dates
WHERE value > ISODate('2018-05-18T16:00:00.000Z')
ORDER BY value DESC

SELECT value FROM dates
WHERE value > ISODate(1526659200000)
ORDER BY value DESC

When you need to find document by ID you must use function :ObjectId

SELECT * FROM documents
WHERE _id = ObjectId('5f9c458018e3c69d0adc0fbd')
ORDER BY value DESC

Currently SQL dialect for MongoDB supports  and :LEFT JOIN INNER JOIN

Executing SQL

Working with dates

Working with object IDs

Working with JOINs
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SELECT
    ar.Name as Artist,
    al.Title as Album,
    SUM(tr.Milliseconds) as Duration
FROM Track tr
INNER JOIN Album al ON tr.AlbumId = al.AlbumId
INNER JOIN Artist ar ON al.ArtistId = ar.ArtistId
GROUP BY Artist, Album
ORDER BY Duration DESC

The only limitation is that you have to specify aliases for both source and target tables in particular order:

SELECT *
FROM <source> <source-alias>
INNER JOIN <target> <target-alias> ON <source-alias>.column = <target-alias>.column

Note that executing following script will not result in merged document but separate documents for  and Track

:Album

SELECT *
FROM Track tr
INNER JOIN Album al ON tr.AlbumId = al.AlbumId
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DBeaver EE supports Cassandra schema browser, data viewer and CQL queries execution. Also it supports 
various administrative tools.

You can connect directly to a server or use SSH tunneling or SOCKS proxy. DBeaver uses DataStax Java driver 
to operate with server. It supports Cassandra servers 2.x, 3.x or higher.

Cassandra

Overview

Connecting to Cassandra cluster
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You can browse, view, edit and filter Cassandra tables the same way as with regular (relational) tables. However, 
being a distributed key-value database, Cassandra doesn't support any kind of referential integrity. There are no 
foreign keys, references, etc.
Note that Cassandra has very advanced (comparing to relational databases) data type system. Each column may 
be a collection, map or set of values (with very big number of values). In some cases this makes browsing data in 
the "Grid" mode inconvenient.

Browsing Cassandra tables
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CQL  is a kind of very simple SQL language dialect.Cassandra Query Language
It supports simple SELECT queries, DDL statements (like CREATE TABLE) and some other.

You can use standard DBeaver SQL editor to execute CQL queries. DBeaver supports Cassandra query 
execution, results scrolling, data export/import, mock data generation and other features. Data viewer (of individual 
tables or custom CQL query results) query tracing is supported.

Executing CQL

http://cassandra.apache.org/doc/4.0/cql/
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Physical ERD (Entity Relation Diagram) doesn't make much sense for Cassandra as there are no any foreign 
keys. However you can make you own  and connect actual Cassandra table with each other using custom ERD
logical associations.

ERD
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DBeaver EE supports InfluxDB schema browser, data viewer and InfluxQL queries execution.
DBeaver uses InfluxDB Java driver 2.12 to operate with the server over HTTP/HTTPS (standard InfluxDB 
protocol).
It supports InflixDB servers of any version (in the moment of writing).

You can connect directly to a server or use SSH tunneling or SOCKS proxy.

InfluxDB

Overview

Connecting to Influx Server
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InfluxDB is , it doesn't support tables, foreign keys and other relational entities.TimeSeries database

DBeaver doesn't support data insert/update in InfluxDB. Basically for DBeaver database is in read-only state. You 
can browse schema and view/analyse data.
While data itself is loaded by various sensors/data collectors in real time.
Instead of tables InfluxDB has . Instead of columns it has  and .measurements fields tags

Browsing InfluxDB schema

https://docs.influxdata.com/influxdb/v1.6/concepts/crosswalk/
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#measurement
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#field-key
https://docs.influxdata.com/influxdb/v1.6/concepts/key_concepts/#tag-key
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InfluxQL is a query language similar to SQL.
DBeaver fully supports all InfluxQL statements. Query results are presented as grid or as graphs:

Executing InfluxQL

https://docs.influxdata.com/influxdb/v1.6/query_language/
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DBeaver EE supports Redis key browser, key value viewer and Redis commands shell.
DBeaver uses  driver 2.9.0 to operate with  server. It supports Redis servers of any version.Jedis Redis

You can connect directly to a server or use SSH tunneling or SOCKS proxy.

Redis

Overview

Connecting to Redis Server

https://github.com/xetorthio/jedis
https://redis.io


DBeaver User Guide 21.0. Page 275 of 334.



DBeaver User Guide 21.0. Page 276 of 334.



DBeaver User Guide 21.0. Page 277 of 334.

You can view/edit Redis keys a plain list. However Redis database usually contains a lot of keys (millions or even 
billions) and using list presentation is not convenient (or is not possible).
DBeaver supports hierarchy presentation of keys. Internally Redis doesn't support hierarchies but on application 
level key names may be divided on groups using some character (e.g. coma, dash or colon). DBeaver uses this 
pattern to show hierarchy. Group separator can be configured in connection properties.

Key browser may be convenient in some cases but in case of big databases it is very uneasy to find your key in 
navigator and SQL editor should be used instead. Redis  are the most flexible way to operate with commands
keys.

Browsing Redis keys

https://redis.io/commands


DBeaver User Guide 21.0. Page 278 of 334.



DBeaver User Guide 21.0. Page 279 of 334.

Redis doesn't support SQL or any other query language. Instead of that it supports  and build-in commands LUA 
.scripts

Redis commands can be executed in the same way as in Redis comand line shell:

In order to execute a command run it using CTRL+Enter or ALT+X. All standard DBeaver SQL editor shortcuts are working for Redis as well.

In order to execute LUA script surround it with {} brackets and run as single statement. If script contains empty lines or special characters select script text before execution.
```lua
{
    return {1,2,{3,'Hello World!'}}
}
```

Executing Redis commands

https://redis.io/commands
https://redis.io/commands/eval
https://redis.io/commands/eval
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Table data view

Table data edit in document (json) mode

Data filters

SQL queries execution

JSON queries execution

Data export and import

DBeaver supports AWS Cloud and Standalone versions of DynamoDB.
For standalone server you need to enter endpoint (http or https URL).
For cloud server you must enter AWS region. DynamoDB exists in all available regions in your AWS account but 
tables are different.

AWS Access Key and Secret Key are used for authentication.
For 3rd-party account access you must specify 3rd party account ID (12-digits number) and 3rd party role name. 
This role will be used for permission management. You account must be added to whitelist in the 3rd party 
account.

AWS DynamoDB

Supported features:

DynamoDB connection
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Press "Test Connection" to validate your connection settings.

DynamoDB has simple metadata structure. Basically you can access only Table and Global tables.
Table has primary attributes (a kind of primary key) and indexes.
DynamoDB is document-oriented database. Each table may have its own set of attributes and sub-attributes.

You can open table editor and see table data.
You may need to switch to the "Data" tab. By default DBeaver converts DynamoDB documents into table format 

Database navigation

Viewing table data
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but you can switch to another data representation.
You can use data filters in order to find documents.

Viewing data in JSON document format
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You view, search and edit JSON documents. Double-click on a document to activate editor.

DBeaver support simple SQL dialect for DynamoDB.
You can use WHERE clause in the same fashion as in regular SQL in order to find or filter documents.

You can also use JSON requests syntax to query documents. See .Amazon DynamoDB query reference

Executing queries

https://docs.aws.amazon.com/amazondynamodb/latest/APIReference/API_Query.html
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You can export data from DynamoDB table in different file formats (CSV, XLSX, XML, JSON, etc) or export data 
directly to another table.

Exporting and importing data
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AWS DocumentDB is based on the  engine.MongoDB
It has several minor differences in the query processing and network configuration.
However most features which work for MongoDB will work for DocumentDB as well. Please refer to  MongoDB
article.

AWS restricts direct access to DocumentDB clusters from outside of the cloud (region). So you can connect to it 
directly (using cluster host name) only when DBeaver is deployed on the EC2 instance.

In other cases you will need to use SSH tunnel thru a proxy machine to access DocumentDB instance. Please 
read AWS Documentation about proxy configuration: https://docs.aws.amazon.com/documentdb/latest
/developerguide/connect-from-outside-a-vpc.html

In DBeaver you can use SSH tab on the connection settings page. Just enter proxy host, user name and specify 
private key file (it is provided by AWS as a keypair).

DBeaver processes DocDB SQL queries exactly like in . It supports SELECT, UPDATE, INSERT and MongoDB
DELETE queries.
SELECT queries support WHERE, ORDER BY, GROUP BY and HAVING clauses.

DocumentDB restricts  function so all JavaScript queries will be parsed on the client side and then evaluated eval

at DocDB cluster one by one. Most of JS functions works exactly like in Mongo Shell.

AWS DocumentDB

Connections

Queries

https://docs.aws.amazon.com/documentdb/latest/developerguide/connect-from-outside-a-vpc.html
https://docs.aws.amazon.com/documentdb/latest/developerguide/connect-from-outside-a-vpc.html
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Couchbase client uses  to connect to a cluster (8091-8096, 9140, etc). Some of these ports are multiple ports
dynamic (i.e. depend on server settings) and can't be overwritten. It makes SSH tunnelling impossible. Thus, if you 
work with remote Couchbase deployed behind a firewall you will need to setup VPN connection or SOCKS proxy.

Couchbase

Connecting to Couchbase server

https://docs.couchbase.com/server/current/install/install-ports.html
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Couchbase is a document-oriented database. It means that all documents may have different structure.
You can view/edit buckets content as standard relational tables (grid/plain text presentations) or as JSON 
documents.

Viewing and editing Couchbase tables
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Couchbase uses  for queries. It is very similar to the standard SQL language.N1QL language

SELECT country FROM `travel-sample` WHERE name = "Excel Airways";

Executing Couchbase queries

https://docs.couchbase.com/server/current/getting-started/try-a-query.html
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Hive is a Hadoop-based storage system. Hive uses a special SQL dialect (HiveQL) to operate with data and 
metadata. Generally, it is quite similar to SQL.

There is multiple implementation of storage systems which utilize Hive on server-side - including Apache Spark, 
Impala, etc. Most of them support standard Hive JDBC driver which is used in DBeaver to communicate with the 
server.

DBeaver uses so-called Hive JDBC Uber Jar driver ( ) which includes https://github.com/timveil/hive-jdbc-uber-jar
all necessary dependencies. You don't need to download anything - DBeaver will download everything 
automatically (if you have internet access).

Apache Hive/Spark/Impala

Apache Hive

Connection setup

https://github.com/timveil/hive-jdbc-uber-jar
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Schema/data browser
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Limitations
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Hie doesn't support referential integrity so you won't see primary keys or foreign keys. ER diagrams also don't 
make much sense.
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You can install a lot of optional extensions (plugins) in DBeaver. Most of extensions can be found on Eclipse 
 website.Marketplace

Darkest Dark theme - the best Dark theme for DBeaver

Eclipse Color Theme - use it if you don't like Darkest Dark theme by some reason

Git support - Git version control integration

Subversion support - Subversion integration

Embedded Shell - Allows to run shell commands directly from DBeaver

Editor vertical indents - Adds vertical indents to all text editors

Office formats support (XLSX)

Vector graphics support (SVG)

SSHJ and advanced cryptography

SQL debugger

In DBeaver EE you can use drag-n-drop from Marketplace web site (see button ) into DBeaver main Install

window. This will launch Marketplace installation wizard automatically. In DBeaver Community or other DBeaver-
based products which do not include marketplace clients you can use following instructions:

Installing extensions - Themes, version control, etc

Popular extensions for DBeaver

DBeaver-specific extensions

Install Process

Extension installation in CE version:

https://marketplace.eclipse.org/
https://marketplace.eclipse.org/
https://marketplace.eclipse.org/content/darkest-dark-theme-devstyle
https://marketplace.eclipse.org/content/eclipse-color-theme
https://marketplace.eclipse.org/content/egit-git-integration-eclipse
https://marketplace.eclipse.org/content/subclipse
https://marketplace.eclipse.org/content/easyshell
https://marketplace.eclipse.org/content/indent-guide
https://marketplace.eclipse.org/content/dbeaver-office-integration
https://marketplace.eclipse.org/content/dbeaver-svg-support
https://marketplace.eclipse.org/content/dbeaver-sshj-support
https://marketplace.eclipse.org/content/dbeaver-sql-debugger


DBeaver User Guide 21.0. Page 298 of 334.

1.  

2.  

3.  

Copy URL of extension update site: 

In DBeaver main menu open Help -> Install New Software

Paste update site URL into  field and press Work with Enter
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4.  Check items you wish to install (in most cases just all items) 
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5.  

6.  

7.  

Click Next. You may need to accept extension license before installation 

Some extensions may contain unsigned bundles. Install such extensions only if you really trust author. 

Click Next->Finish. Installation will take some time. Restart DBeaver.
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Command line parameters might be passed directly to dbeaver[.exe] executable.
On Windows you also can use  executable (it doesn't spawn new window so you can see output dbeaver-cli.exe

messages).

Also you can add parameters in the  configuration file (in the beginning, each parameter on its own dbeaver.ini

line).

Name Value Example

-help Prints help message

-stop Quits DBeaver

-dump Prints DBeaver thread dump

-f Opens file in DBeaver UI -f c:\some-path\some-file.sql

-con Opens database connection in DBeaver UI See connection parameters table

-closeTabs Closes all open editor tabs

-disconnectAll Closes all open connections

-
reuseWorkspace

Force reuse of single workspace by multiple DBeaver 
instances

-newInstance
Force new DBeaver instance creation (do not try to reuse 
already running one)

-var 

Custom variables for runTask. You can change existing 
variables in the task, you cannot add new task variables with 
this parameter. You can add several parameters at once to 
the command line, each starting with "-var". Used right 
before -runTask. Template: "-var 
variableName=variableValue"

-var film=sakila.film

-var actor=sakila.actor

-runTask "exportFromSakila"

EE version only.

-runTask Executes specified task
-runTask "@projectName:taskName" .

EE version only. See .task scheduler

-license Path to the EE license file
-license "/etc/licenses/dbeaver.txt"

.
EE version only.

Name Value Example

Command Line

Command line parameters

DBeaver control

System parameters
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-nl Locale en_US

-data Workspace path c:\ProgramData\MyWorkspace

-nosplash Omits splash screen true

-clean Clears all Eclipse caches. Use it if DBeaver fails to start after version upgrade.

-vmargs VM parameters See VM arguments table

You can pass any advanced Java parameters supported by your local JVM (Oracle, OpenJDK, IBM, etc).
Parameters supported by Oracle JVM (11): https://docs.oracle.com/en/java/javase/11/tools/java.html

Parameters supported by all JVMs:

Name Value Example

-Xms Sets initial memory available for DBeaver -Xmx1000m

-Xmx Sets maximum memory available for DBeaver -Xmx4000m

All connection parameters must be supplied as a single command line argument, parameters are divided by pipe (
). Parameter name and value are divided by .| =

Example: -con driver=sqlite|database=C:\db\SQLite\Chinook.
db|name=SQLiteChin|openConsole=true|folder=SQLite

Name Value Example

name Connection name Test connection

driver Driver name or ID driver=sqlite , , etcdriver=mysql

url
Connection URL. Optional (JDBC 
URL may be constructed by driver 
from other parameters)

url=jdbc:sqlite:C:\db\SQLite\Chinook.db

host Database host name (optional) host=localhost

port Database port number (optional) port=1534

server Database server name (optional) server=myserver

database Database name or path (optional) database=db-name

user User name (optional) user=root

password User password (optional) password=mysecret

auth
Authentication model ID. See Auth 
models

auth=postgres_pgpass

authProp.propName
Custom authentication parameters 
(depends on driver and )auth model

authProp.oracle.net.wallet_location=C:/temp/ora-wallet

savePassword Do not ask use password on connect savePassword=true

VM arguments

Connection parameters

https://docs.oracle.com/en/java/javase/11/tools/java.html
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showSystemObjects Show/hide system schemas, tables ,
etc

showSystemObjects=true

showUtilityObjects Show/hide utility schemas, tables ,etc showUtilityObjects=true

folder Put new connection in a folder folder=FolderName

autoCommit
Sets connection auto commit flag 
(default value depends on driver)

autoCommit=true

prop.propName
Advanced connection parameters 
(depend on driver)

prop.connectTimeout=30

id Connection id
oracle_thin-16a88e815bd-70598e648cedd28c  (useful in 

conjunction with )create=false

connect Connect to this database connect=false

openConsole
Open SQL console for this database 
(sets  to true)connect

openConsole=true

create Create new connection
create=false  (true by default). If set to false then existing 

connection configuration will be used. name or id parameter 
must be specified.
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1.  

2.  

3.  

Sometimes, usually after multiple version and /or upgrades/incorrect shutdowns DBeaver UI may become 
corrupted. Extra toolbar elements, missing menu items, broken keyboard shortcuts, broken localization strings and 
other glitches may happen.

To reset DBeaver UI just delete file  in DBeaver workspace/.metadata. By default workbench.xmi workbench.xmi

file locations is:

Windows: %APPDATA%\DBeaverData\workspace6\.metadata\.plugins\org.eclipse.e4.workbench\workbench.xmi

MacOS: ~/Library/DBeaverData/workspace6/.metadata/.plugins/org.eclipse.e4.workbench/workbench.xmi

Linux: 
$XDG_DATA_HOME/DBeaverData/workspace6/.metadata/.plugins/org.eclipse.e4.workbench/workbench.xmi

To reset settings:

Close DBeaver

Delete workbench.xmi from Explorer/Finder or open terminal and run  (Windows) or  (Linux/MacOS) del rm

followed by workbench.xmi path.

Start DBeaver

Reset UI settings
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1.  

2.  

3.  

4.  

Sometimes (especially after multiple DBeaver versions upgrade) workspace become messy.
Some keyboard shortcuts may stop working, toolbars layout may be broken, etc, etc.
To reset all UI settings (this includes menus, shortcuts, view and toolbar layouts):

Shutdown DBeaver

Go to the default workspace folder .metadata\.plugins\org.eclipse.e4.workbench\

Windows: , enter Win+R
%APPDATA%\DBeaverData\workspace6\.metadata\.plugins\org.eclipse.e4.workbench\

MacOS: open ~/Library/DBeaverData/workspace6/.metadata/.plugins/org.eclipse.e4.workbench/

Linux: cd $XDG_DATA_HOME/DBeaverData/workspace6/.metadata/.plugins/org.eclipse.e4.workbench/

Delete file workbench.xmi

Start DBeaver

If that doesn't help then you can try to remove  folder..metadata/.plugins/org.eclipse.core.resources

If that doesn't help then remove  folder. It will erase all your UI settings (but all connections, settings .metadata

and scripts will remain as is).

That's it.

Reset workspace
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A few tips.

Check existing issues for your issue (including closed ones). Duplicating an issue is slower for both parties so 
search through open and closed issues to see if what you’re running into has been addressed already.

Be clear about what your problem is: what was the expected outcome, what happened instead? Detail how 
someone else can recreate the problem.

If you posting a bug report check "Error Log" view. If there are any errors related to your bug then post a 
complete stacktrace. Sometimes there are no errors in Error Log - then try to find them in .log files

If your issue is related to a database data or metadata management - check the Query Manager view. It 
contains information about all queries DBeaver executes (explicitly or implicitly). To see more detailed 
information you can configure Query Manager in Preferences. 

Depending on the nature of your bug report provide information about:

Operating system

Window manager (for Linux)

Database (name and version)

Database driver (name and version)

Do not write issue type in the issue title (like Feature Request:, Bug: etc). We'll review your issue and assign 
a corresponding label.

Posting issues
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There is Error Log view (main menu Window->Show View->Error Log) which contains all errors occurred during 
DBeaver runtime.
You can double click on warning/error in the log viewer and see error stacktrace. Please attache it to the bug 
report.
Also you can open full log (all error messages) if you need:

DBeaver writes different log files. Most of them are Eclipse logs.
Usually log files reside in the /workspace6/.metadata .workspace

On Windows open Explorer and paste path .%APPDATA%\DBeaverData\workspace6\.metadata

On Linux just type cd $XDG_DATA_HOME/DBeaverData/workspace6/.metadata

On MacOS open path  in Finder.~/Library/DBeaverData/workspace6/.metadata

To view hidden folders press  in the folder view.Cmd+Shift+.

Two standard log files:

workspace/workspace6/.metadata/.log - all warnings and errors which happens during normal work

workspace/workspace6/.metadata/dbeaver-debug.log - the same as  plus debug information.log

In special cases log files can be written in other directories. Special case is an emergency situation when DBeaver 
can't start and there is no workspace. Two typical places to find emergency logs:

<install-path>/configuration

${HOME}/.eclipse/org.jkiss.dbeaver.product_<dbeaver-version>

If you are reporting about some error please attach logs (not complete file but valuable part of it).
Logs are very useful, big number of errors can't be reproduced/fixed without full error stacktrace.

Log files

Error Log view

Log files

Java fatal logs
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In rare cases DBeaver process dies and doesn't leave any valuable logs. This caused by Java VM crash.
JVM creates a fatal log file for each crash (log gile ). This log usually resides in the same hs_err_PID.log

directory where dbeaver launcher is (e.g. dbeaver.exe).
But in some cases it is a write-protected directory and log file will be created in other folder.
Instruction how to find Java fatal log file: https://docs.oracle.com/javase/9/troubleshoot/fatal-error-log.htm

https://docs.oracle.com/javase/9/troubleshoot/fatal-error-log.htm
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1.  

2.  

3.  

4.  

5.  

6.  

In some cases custom JDBC drivers work incorrectly in DBeaver - shows wrong metadata like table columns, 
constraints or foreign keys.
Usually it happens because driver isn't compliant with JDBC API specification and DBeaver can't correctly interpret 
metadata provided by driver.

To understand what is going on inside driver you can enable JDBC tracing:

Find  file (it is located in the same folder where DBeaver is installed)dbeaver.ini

Add line  in the end of -Ddbeaver.jdbc.trace=true dbeaver.ini

Restart DBeaver

Connect to your database and browse metadata in the database navigator/object editors.

In DBeaver  go to  folderWorkspace .metadata

File  contains all JDBC API invocations and all queries with results.jdbc-api-trace.log

Analyzing contents of  you can understand what is wrong with metadata. Attach piece of jdbc-api-trace.log

trace file in GitHub ticket if you think that something is wrong on DBeaver side.

WARNING: disable JDBC tracing in your regular work. Enable it only for debugging. Trace generation decreases 
application performance and may produce huge log files.

JDBC trace
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Sometimes (due to some bug) DBeaver UI hangs, freezes or works incorrectly. Usually it is impossible to find the 
reason of such problem without thread dump. Thread dump is the information about internal execution state of 
Java program. To get thread dump:

Run the following on your terminal:

jstack $(ps aux | grep -m1 dbeaver | awk '{print $2}') > thread-dump.txt

Just open task manager (CTRL+Escape), find DBeaver in the process list and copy process ID value. On 
Windows 8+ you need to switch to "Details" tab. Run

jstack <PID> > thead-dump.txt

in Command Prompt.

Now you can attach thread-dump.txt to the GitHub issue.

Thread dump

Mac and Linux

Windows
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Sometimes DBeaver needs to access external internet resources for such tasks as:

3rd party JDBC drivers download

Information about new DBeaver version

Connect to remote databases outside of your corporate network

Subscription license activation (commercial version)

License information update (commercial version)

If you are behind some corporate firewall which restricts access to external internet resources then it may become 
a real problem.
Sometimes corporate firewalls allows to access external resources using web browser but restricts this for all other 
applications.

You need ask your network administrator about proxy parameters.
Then go to Preferences->Connections->Drivers.

You can enter proxy host/port and (optionally) user/password here. It will be used for drivers download only.

Proxy configuration

External resources access

How to configure proxy for drivers download
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Drivers are usually downloaded from maven.org web site. You also may ask your network admin to add 
 to the list of allowed external domains.maven.org

You need to configure global proxy server.
If you can't activate your subscription license then you first need to use trial version to start DBeaver and configure 
proxy.

Go to Preferences->General->Network Connections: 

Switch to Manual or Native proxy (native proxy settings will use active web browser proxy configuration).
Note: in order to activate/update license DBeaver needs access to web site  only. You may ask your dbeaver.com

network administrator to add  to the white list.dbeaver.com

You can configure proxy settings for individual connection.
You may set proxy settings manually or use active OS/web browser settings:

How to configure network for license activation

How to configure proxy for external databases access
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This guide describes how to manage/secure DBeaver database connections. It is designed for System 
administrators. Regular users should check  guide.this

DBeaver keeps connections information in project folder. By default all projects reside in .workspace
Default project folder is \workspace6\General.workspace

DBeaver keeps information about project connections in file ..dbeaver/data-sources.json

All secured information (user name, password, secret keys, etc) is stored in the encrypted file 
..dbeaver/credentials-config.json

DBeaver can load multiple connection files. Any files in project folder matching  .dbeaver/data-sources*.json

pattern will be loaded on startup. So you can create a file, say,  in the project .dbeaver/data-sources-2.json

folder and DBeaver will see it.

DBeaver keeps information about project connections in file .dbeaver-data-sources.xml

DBeaver can load multiple connection files. Any files in project folder matching  .dbeaver-data-sources*.xml

pattern will be loaded on startup. So you can create a file, say,  in the project folder .dbeaver-data-sources-2.xml

and DBeaver will see it.

You can import connection from CSV or XML files.

CSV file must have a header row (first line of file) with column names (see list of supported columns below). XML 
file should contain top-level element and a set of nested elements. Connections config must be specified in 
attributes of nested elements. Attribute names are the same as CSV column names.

Name Meaning

name Connection name

url JDBC URL

host Database server host name

port Database server port

database Database/schema name

Managing connections

Provide predefined connections

DBeaver 6.1.3+

DBeaver < 6.1.3

Importing connections from CSV/XML

Supported names:
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user User name

password User password

You can specify just URL or set host/port/etc setting.
User name/password are options.

name,host,port,server,database,url,user,password,type
Postgre Import XML 1,localhost,5432,,postgres,jdbc:postgresql://localhost:5432/postgres,postgres,postgres,dev
Postgre Import XML 2,localhost,5432,,postgres2,jdbc:postgresql://localhost:5432/postgres2,postgres2,postgres2,prod

<connections>
        <connection name="Postgre Import XML 1" host="localhost" port="5432" server="" database="postgres" url="jdbc:postgresql://localhost:5432/postgres" user="postgres" password="postgres" type="dev" />
        <connection name="Postgre Import XML 2" host="localhost" port="5432" server="" database="postgres" url="jdbc:postgresql://localhost:5432/postgres2" user="postgres2" password="postgres2" type="prod" />
</connections>

It is possible to make connection settings read-only (protected by password)

Generate MD5 hash of your password. You can do it from command line using Linux utility md5sum (
) or you can do it online - just google "MD5 hash online".md5sum <<<"your password"

Add field  in connection descriptor (in  in  element. lockPassword .dbeaver/data-sources.json connections

So it will look like this:

postgres-jdbc-161537836e8-3e0957d039995715": {
   "provider": "postgresql",
   "driver": "postgres-jdbc",
   "name": "PostgreSQL - postgres",
   "save-password": true,
   "show-system-objects": true,
   "read-only": false,
   "folder": "PG",
   "lockPassword": "2ba81a47c5512d9e23c435c1f29373cb"
...
}

Now if user will try to change connection settings he/she will be asked for password

Sample CSV

Sample XML

Secure connections from editing
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You can customize drivers configuration in /.metadata/.plugins/org.jkiss.dbeaver.core/drivers.xml file. If workspace
you have some pre-installed jar files you can reference them in drivers.xml. Example:

<library type="jar" path="absolute-jar-folder-path\driver-jar.jar" custom="true" />

Also in drivers.xml you can use following variables to specify relative paths:

Variable Meaning

drivers_home Standard DBeaver drivers location - ($workspace/drivers by default)

dbeaver_home DBeaver installation folder

home User home folder

workspace DBeaver workspace path

For instance:

<library type="jar" path="${workspace}\drivers\my-driver.jar" custom="true" />

Full drivers.xml example:

<?xml version="1.0" encoding="UTF-8"?>
<drivers>

        <provider id="postgresql">
                <driver id="postgres-jdbc" custom="false" embedded="false" name="PostgreSQL" class="org.postgresql.Driver" url="jdbc:postgresql://{host}[:{port}]/[{database}]" port="5432" description="PostgreSQL standard driver">
                        <library type="jar" path="maven:/org.postgresql:postgresql:RELEASE" custom="false" version="42.2.3">
                                <file id="org.postgresql:postgresql" version="42.2.3" path="${drivers_home}/maven/maven-central/org.postgresql/postgresql-42.2.3.jar" />
                        </library>
                        <library type="jar" path="maven:/net.postgis:postgis-jdbc:RELEASE" custom="false" version="2.2.1">
                                <file id="net.postgis:postgis-jdbc" version="2.2.1" path="${drivers_home}/maven/maven-central/net.postgis/postgis-jdbc-2.2.1.jar" />
                        </library>
                        <library type="jar" path="maven:/net.postgis:postgis-jdbc-jtsparser:RELEASE" custom="false" version="2.2.1">
                                <file id="net.postgis:postgis-jdbc-jtsparser" version="2.2.1" path="${drivers_home}/maven/maven-central/net.postgis/postgis-jdbc-jtsparser-2.2.1.jar" />
                        </library>
                </driver>
        </provider>

</drivers>

In some cases you may need to provide drivers configuration or driver jar files for a number of DBeaver 
installations automatically.
This can be done by adding special parameter in the  file: dbeaver.ini

-Ddbeaver.drivers.configuration-file=c:\some-path\dbeaver-drivers-config.xml

This file has the same structure as  file (see above) and it will be loaded  .drivers.xml before drivers.xml

You can specify partial driver configuration. For example if you need to configure only jar path then it may look like 
this:

Managing drivers

Configure drivers with pre-installed jars

Provide predefined drivers configuration
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<?xml version="1.0" encoding="UTF-8"?>
<drivers>

  <provider id="generic">
    <driver id="netezza">
      <library type="lib" path="X:\jdbc-drivers\netezza-jdbc.jar" />
    </driver>
  </provider>
</drivers>
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It is possible to install DBeaver in silent mode using Windows Installer command line parameters.
This might be very useful for mass install automation (SSCM and other similar systems).
Installer was improved in DBeaver 5.3.3, special thanks to  team.https://github.com/Drizin/NsisMultiUser

Command line parameters supported by DBeaver installer:

Parameter Description

/S silent mode, requires /allusers or /currentuser, case-sensitive

/D=path (installer only) set install directory, must be last parameter, without quotes, case-sensitive

/allusers (un)install for all users, case-insensitive

/currentuser (un)install for current user only, case-insensitive

/uninstall (installer only) run uninstaller, requires /allusers or /currentuser, case-insensitive

In order to install with /allusers parameter current user must have administrator permissions.

Code Meaning

0 normal execution (no error)

1 (un)installation aborted by user (Cancel button)

2 (un)installation aborted by script

666660 invalid command-line parameters

666661 elevation is not allowed by defines

666662 uninstaller detected there's no installed version

666663 executing uninstaller from the installer failed

666666 cannot start elevated instance

other Windows error code when trying to start elevated instance"

Windows Silent Install

Parameters

Installer return codes (decimal):

https://github.com/Drizin/NsisMultiUser
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Note: This functionality is available only in .Enterprise Edition

DBeaver EE asks user to import license file if this file cannot be found in the local license storage. For individual 
users this is the most simple and convenient way to import product license.

There are several ways to automate license management process. It makes sense for multi-user environment.

On start DBeaver will look for license file in the following locations:

Windows
%HOMEPATH%\.dbeaver-ee-license.dat

%APPDATA%\DBeaverData\workspace6\.metadata\.dbeaver-ee-license.dat

MacOS X
~/.dbeaver-ee-license.dat

~/Library/DBeaverData/workspace6/.metadata/.dbeaver-ee-license.dat

Linux
~/.dbeaver-ee-license.dat

$XDG_DATA_HOME/DBeaverData/workspace6/.metadata/.dbeaver-ee-license.dat

You can add command line parameter  to the DBeaver EE shortcut. Also you can add license <license-path>

this parameter to  config file.dbeaver.ini

License Administration

Manual license import

License management automation

Put the license file to the predefined locations

Passing license file through command line
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Command line reference.
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Import from email

Import from the personal account

Insert the License key to License Manager

Import of Subscription license

Import of License extension

License Manager

To start using DBeaver EE you can

request a  for 2 weeks;Trial license

request an  if you are a student or a teacher;Academic license

buy Subscription license, Standard DBeaver EE license or DBeaver EE license extension.

After purchase DBeaver EE license or getting Trial/Academic license you receive a License Key by email. Also, it 
is available in your personal account on our . The License Key is a unique identification number that contains site
License ID e. g. DB-821MPZFO-ZA8W, Start date and license owner’s name and company name. It is very 
important to import your License Key correctly.

You can just copy-paste License Key to import the license into the License Manager. Please, note that you need 
to copy-paste full license text (not just license ID). The license text starts with “–” and ends with “==” characters.

How to Import License

Import from email

https://dbeaver.com/trial/
https://dbeaver.com/academic-license/
https://dbeaver.com/buy/
https://dbeaver.com/
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Sometimes an email client can corrupt the formatting of the License Key that can cause an error.

Therefore, you need to import your License Key from your personal account on our site .https://dbeaver.com/

Import from the personal account

https://dbeaver.com/


DBeaver User Guide 21.0. Page 323 of 334.

Firstly, you need to .Sign in

Secondly, you should open the  tab, where you can find all your licenses.Licenses

To open the License details and copy the License Key you press the  button. You can see the License details View
where you can find your license status, type, maintenance period, end support date. Also, you can reassign the 
license to another user.

https://dbeaver.com/signin/
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At the bottom of the page you can find the License Key required to start using DBeaver EE. There are two options 
how to copy your License Key from the personal account:

1)Press the  button, then press OK. The license text will be copied to clipboard.COPY TO CLIPBOARD

2)Press the  button, then press OK.DOWNLOAD LICENSE
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.txt file with your License Key will be downloaded to your download folder. The file name is License ID, e. g. DB-
821MPZFO-ZA8W.

Then you need to insert copied License Key to License Manager in Dbeaver EE.

To start using DBeaver EE with your License Key you need to open License Manager in DBeaver EE: Help -> 
DBeaver License Info

The License information window can look different depending on whether have you already a valid license or not.

Insert the License key to License Manager
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Then you click  where you can find all your imported licenses and information about them.License Manager

Next you press the  button to paste your License Key.Import

If you copied the License Key to clipboard, press the  button and then .Paste Import
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If you downloaded the .txt file with the License Key, press the  button and then select the file from Load
Downloads. The License Key will be pasted automatically.

Then press the  button and your license will be added in License Manager.Import

You have successfully imported your license. Now you can close License Manager and start using Dbeaver EE.
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Subscription license requires an internet access on the workstation for the first activation and each prolongation.

If you do not have an active internet connection or work behind a corporate firewall while importing the 
Subscription license, the following error can appear:

Invalid subscription

Can`t find subscription information for license ‘DB-821MPZFO-ZA8W’.

Check your internet connection and/or firewall settings and restart application.

In this case you need to check that DBeaver EE has an internet access or to configure firewall.

Standard DBeaver EE license is a perpetual license with a limited period of support (1 year or 2 years).

After the end of the selected support period you can continue to use DBeaver Enterprise Edition without support 
and updates or buy a license extension or a new license.

If you buy DBeaver EE license extension and Dbeaver has an internet access, the license in DBeaver EE will be 
updated automatically. Otherwise, you have to import the license key from the personal account once again.

License Manager provides you with the following information about your licenses:

License ID e. g. DB-821MPZFO-ZA8W;

License type: Trial/Academic/Subscription/Standard;

Version;

License owner`s name and company name;

License owner`s email;

Start time is the date the license was received;

End time is the date of license expiration (standard perpetual licenses don`t have it)

Number of users: single user or multiuser for group licenses;

Support period is a period while you have access to the internal support system on the site and a possibility to 
download new product versions;

State: valid or expired.

Import of Subscription license

License extension

License Manager
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After purchase a bunch of DBeaver EE licenses you have to assign each license to an end user.

If an employee subsequently is leaving the company or the team that is using DBeaver, the license admin may 
need to reassign the license to another employee.

You can reassign the license to another user in your personal account.

Firstly, you need to .Sign in

Secondly, you should open the , where you can find all your licenses.Licenses tab

You select which license you need to reassign and press the  button near its license ID. You can see the VIEW
License details where you can find your license status, type, maintenance period, end support date.

How to Reassign License

https://dbeaver.com/signin/
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Also, there is the license end user field that contains license end user's details. To reassign the license, you need 
to press the  button near this field.CHANGE END USER

A pop-up opens, and you can enter new license end user data: email, first and last name, company. After filling 
the form, you need to press the  button and the license owner will be changed. The license key that contains SAVE
license end user’s name and company name will be changed too.
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The license will remain in your personal account. The end user's email will be in the end user column on the 
Licenses tab.
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Also, new license end user will be able to find the license in the personal account and to . There will be no import it
the CHANGE END USER button since only the license customer can assign a license to the end user. If new 
license end user hasn't been signed up on our website, the account will be created automatically. New user will 
receive a welcome email with a link to set up a password.

https://dbeaver.com/docs/wiki/How-to-Import-License/
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